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Medications and prescriptions

In Wolf EMR, you can create and print prescriptions from any window related to a patient’s record (via
the right-click menu).

Once a medication has been prescribed for a patient, you can:

n Reprint the prescription

n Modify the prescription

n Refill the prescription

n Discontinue the prescription

n Delete the prescription

Wolf EMR tracks a patient’s active medications (current) and inactive medications (previous) in the
medical summary, and displays the patient’s medication history, along with the patients allergies, in
the prescription entry window. This way, you can view pertinent information at-a-glance when making
decisions on what medication(s) to prescribe to a patient.

If your clinic receives refill requests from pharmacies, front-end staff and other clinical staff can queue
requested prescriptions and send the prescriptions to the patient’s provider for review.

Creating prescriptions

You can prescribe a medication from almost any window related to a patient via the SMART menu.
Wolf EMR contains an extensive searchable medications list, enabling you to quickly select an
appropriate medication to prescribe.

You can enter prescription directions using discrete entry fields (for example, for dose, frequency,
and duration), or you can enter prescription directions as free-text in the instructions field. Using a
variety of entry options, you can create:

n Basic prescriptions (see "Creating basic prescriptions" on the next page)

n PRN prescriptions (see "Prescribing PRN (take-as-needed) medications" on page 21)
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n Prescriptions for compound medications (see "Prescribing compound medications" on
page 20)

n Concurrent dose prescriptions (see "Creating concurrent dose prescriptions" on page 23)

n Sequential dose prescriptions (see "Creating sequential dose prescriptions" on page 25)

n Variable dose prescriptions (see "Creating variable dose prescriptions" on page 27)

n Adjust-as-directed prescriptions (see "Creating adjust-as-directed prescriptions" on page 29)

n Prescriptions for medical devices and other non-medication treatments (see "Prescribing
medical devices and other non-medication treatments" on page 30)

You can print more than one medication on a single prescription printout (see "Prescribing multiple
medications" on page 17). Additional medications on a prescription can be new medications for the
patient, or refilled medications.

When you prescribe multiple medications, the EMR tracks the medications in a visible area, enabling
you to review your prescribed medications before printing the complete prescription.
amox

Creating basic prescriptions

View video tutorial:
Create basic prescriptions and refills

If the video does not play, click here to copy the web address and then paste it into a
web browser outside the Wolf EMR data centre.

When you create a basic prescription, you search for a medication to prescribe, and then enter
prescription instructions using discrete entry fields (for example, for dose, frequency, and duration). If
you enter complete dosage information, the EMR can calculate a quantity.

When you finish a prescription, you can choose to print the prescription. If you are prescribing
multiple medications, you can also choose to save the prescription.

Steps

1. Open the Medications and Allergies window: On any window related to the patient, (including a
patient’s medical summary, or SOAP note), right-click and choose Enter New Medication.

2. If the Medications and Allergies window is already open, click New Medication . The EMR
displays the Search Criteria area.
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The patient’s medications (active and inactive) and allergies (active and inactive) display in the left
pane. See "Viewing patient medications" on page 47 and "Viewing patient allergies and
intolerances" on page 93.

3. Search for a medication to prescribe:

a) In the Search Criteria area, in the Medication field, enter part or all of the medication name.
You must enter at least three characters.

b) To narrow or expand your medication search criteria, using the following table, select or
clear filtering options.

Option Description

Starts with Displays only medications with names that start with your search term.

Contains Displays medications with names that contain (but do not have to start
with) your search term.

Sounds like Displays medications that phonetically match your search term, even if the
search term is misspelled.

Tip: Select this option for hard-to-spell medications.

Include
Generic

Includes non-brand-name medications in your search results.

Include OTC Includes over-the-counter medications in your search results.

Include IV Includes intravenous medications in your search results.

7

Medications and prescriptions



Option Description

Include
Discontinued

Includes medications that are no longer available on the market in your
search results.

Route To display only medications that are administered through a specific route
(for example, “oral”), select an option.

Dose Form To display only medications that are available in a specific form (for
example, “capsule”), select an option.

Tip:
You can change what medication search options are selected for you by
default:

1. From the WorkDesk menu, choose Configure > Configure Workdesk >
Medications tab.

Note: Users with administrator authority in Wolf EMR can set
medication search option defaults for the entire clinic. See
"Configuring medication preferences" on page 78.

a) On your keyboard, press Enter, or click Search. The EMR displays a list of matching
medications, grouped by generic name and a list of matching medication favourites. See
"Creating prescriptions using favourites" on page 43.
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Tip: If you cannot find the medication you are looking for, in the Medication
field, enter only the first three letters of the medication name, and then click
Search once more.

2. In the list of matching medications, click the medication you want. The EMR displays strength
options for the selected medication.

3. Double-click the strength you want. The Prescription SIG Directions area opens.
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Tip: If at this point you decide to prescribe a different medication, on the top right of

the Rx area, click Back . The EMR displays the medication Search Criteria area
again. You can now search for a new medication to prescribe.

4. Manage any medication interaction warnings (see "Managing medication interaction warnings"
on page 33).

5. If you want to prescribe on behalf of another provider, in the Prescriber field, select the provider.
This provider's name will be printed on the prescription.

6. If your clinic has multiple locations sharing the same EMR, in the Location to print on Rx list,
select the location you are seeing the patient at.

7. If you want a list of the patient’s active medications to display on the prescription print-out, select
the Print Medications check box (if it is not already selected), otherwise, clear this check box.

8. In the Pharmacy list, select the patient's pharmacy or, if the patient does not have a regular
pharmacy, choose <<None>>.
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ALWAYS ASK THE PATIENT WHAT PHARMACY THEY WILL GO TO, even if they
have a default pharmacy selected. The patient may wish to use an alternative
pharmacy.

Note:
For new prescriptions, the patient's main pharmacy as entered in the Patient
Maintenance window (Main Pharmacy field) is selected by default. For refills, the
last selected pharmacy for that prescription is selected by default.

If you change the pharmacy, it remains as the default one for the remainder of the
prescription session (until you close the prescription window).

If the pharmacy you want is not in the list, or if a pharmacy’s information is incorrect, you can add
or modify pharmacies:

a) Beside the Pharmacy list, click .

b) Add or modify pharmacies as needed.

Tip:
Pharmacy search tips

n You can filter the list by any column, using the search fields below the column
headers. For example, to view only Coop pharmacies, in the Pharmacy Name
field, type “Coop”.

9. If your clinic has multiple locations sharing the same EMR, in the Location to print on Rx list,
select the location you are seeing the patient at.

10. If you want a list of the patient’s active medications to display on the prescription print-out, select
the Print Medications check box (if it is not already selected), otherwise, clear this check box.

11. Using the following table, in the Prescription SIG Directions area and the Refill Details area, enter
the prescription dose, frequency, duration, and other instructions. As you enter prescription
instructions, the Rx area previews what the prescription description will look like when it is printed.
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Note: If the selected medication has prescription defaults set, the Short
Term/Continuous, Dose, Frequency, Duration, PRN, Anticoagulant and Other
Directions fields and check boxes may auto-populate. You can edit these default
values if needed (see "Modifying defaults for specific medications" on page 84).
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Field Description

Prescription
type list (top-
left of the
Prescription
SIG
Directions
area)

The prescription type you select determines what entry fields are available
in the Prescription SIG Directions area. Options include:

n Simple: Displays basic dose, route, frequency, and duration fields.

n Sequential: Enables you to add multiple dosage lines for
prescriptions where dose directions are different each day or each
week. Each dosage line is connected by a THEN statement. See
"Creating sequential dose prescriptions" on page 25.

n Concurrent: Enables you to add multiple dosage lines for
prescriptions where dose directions are different for different times in
the day. Each dosage line is connected by an AND statement. See
"Creating concurrent dose prescriptions" on page 23.

n Variable: Enables you to add multiple dosage lines for prescriptions
where dose instructions change between days, or weeks in a
patterned manner. The EMR automatically creates dosage lines for
you based on the Initial Dosage, Final Dosage, and the Vary By
amount. See "Creating variable dose prescriptions" on page 27.

n Adjust as Directed: Enables you to free-type prescription directions
without having to fill-in dosage fields. See "Creating adjust-as-
directed prescriptions" on page 29.

n External: Enables you to record that a patient is taking or has
previously taken a medication without prescribing the medication.
When you select this option, you do not have the option to enter any
details about medication dose, frequency, duration and other
prescription details, in structured fields. Instead, you can enter any
prescription instructions in the Other Directions area. See "Recording
medications (without prescribing)" on page 31.

Anticoagulant Select if this is an anti-coagulation medication that requires regular INR
testing. The EMR links the prescription, and future changes you make to
the prescription, to INR test results.

Note: If the medication being prescribed is an anticoagulant
medication, this check box is selected by default.
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Field Description

Information
Rx

If you are recording the medication for informational purposes only, and
do not require a printed prescription for the medication, for example, if this
is a new patient and you are entering the medications the patient is
currently taking, select this check box.

Note: If you select this option, if you print this prescription, the
following message displays on the prescription: “Instructions
to Pharmacist: Informational Only, DO NOT FILL.”

Continuous To indicate that the patient will be using the medication for an extended
period of time (greater than 30 days), select this option.

Note: Continuous medications do not automatically drop-off
the Active Medications list.

Short Term To indicate that the patient will be using the medication for a short period
of time, select this option.

Note: Short term medications are automatically removed
from the Active Medications list as soon as the prescription is
calculated to be exhausted.

Dosing Enter the number or range of capsules, applications, and so on, the
patient should take at a time.

Select the dose type, for example TAB, or mg.

Note: The options available in the Dosing list vary, depending
on the medication being prescribed or recorded.

Tip: If the option you want is not available in the dosage type list, select
<ALL>. The EMR displays a more complete list of dosage type options.

Route Select the route in which the medication is to be taken.

Tip: Type the short-form of the route to quickly filter the list. For example,
type “PO” for oral.
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Field Description

Frequency Select a frequency. If none of the options are appropriate, select OTH
(other) and then, in the Other Frequency field, enter the frequency. For
example, you can enter "Up to 8x/day".

Tip: You can type the short-form for the frequency to quickly filter the list.
For example, type "TID".

prn Select this check box to indicate that a medication is to be taken on an as
needed basis instead of regularly (for example, a pain medication or a rash
cream). If you choose PRN, you do not need to specify a duration as long
as you enter a quantity. You must, however, specify a dose, route, and
frequency. See "Prescribing PRN (take-as-needed) medications" on
page 21.

Duration Enter the duration in weeks, months, or years.

n Duration determines when a short term medication will fall off the
Active Medications list.

n The Duration field is not available if STAT is selected in the Frequency
list.

Other
Directions

Enter any specific instructions for the patient when taking the prescribed
medication (for example, “take with food”, or “apply sparingly”). The
pharmacy will print these instructions on the label they affix to the
medication.

If you are entering an external medication, or an adjust as directed
prescription, enter all prescription instructions in this area.

Tip: In the Other Directions list, you can select pre-defined instructions.
The EMR populates the selected instructions in the Other Directions text
area. You can add more than one pre-defined instruction if desired.

Problem To link this medication to one of the patient’s active problems, select the
problem.

Note: Only problems listed in the patient’s Problems list are
available in the list.
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Field Description

Dispense
Quantity

Enter a dispense quantity, or to calculate the quantity based on the dose,

frequency, and duration details, click .

If the icon is not available, this indicates that there is not enough
information recorded in the dosing line for the EMR to produce an accurate
value.

If the prescription is for a prn, you must enter the dispense quantity if you
do not enter a duration.

In the Dispense Quantity list, select the quantity type.

Tip: If the option you want is not available in the Quantity Type list, click
<ALL>. The EMR displays a more complete list of dosage type options.

Refills Enter the number of refills.

If you enter a 0 in the Refills field, the text “Refills: None” displays on the
printed prescription to inform the pharmacist that it is a one-time only
prescription. This is useful for sensitive prescriptions.

Pharmacist
Instructions

Enter any special instructions for the pharmacy (for example, “patient has
arthritis; needs an easy-open bottle”). These instructions are not meant to
be included on the medication label for the patient.

Start Date Enter the date the patient is to start taking the medication.

Max Disp Qty Enter a value to specify the maximum amount that the pharmacist should
dispense.

Prescriber If you are a provider, your name is selected by default. You cannot create a
prescription under another provider’s name.

Interval Enter a value to specify the minimum time period between dispenses (for
example, 30 days between dispenses for a narcotic.)

Allow
Substitutions

This option is selected by default.

Clear if the pharmacist should not substitute with a generic version or
another brand.

12. If the prescription requires a PharmaCare special authority request form, click the Spec Auth
button. The form is populated with the patient and medication information.

13. Perform one of the following actions:

n To save the current prescription and prescribe another new medication, click Save and New

. If the next medication you are adding has previously been prescribed to the patient, you
can refill the prescription. See "Refilling prescriptions" on page 59.
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Note: If you have prescribed multiple medications, you can print them on the
same prescription print-out. See "Prescribing multiple medications" below.

n To save a single-medication prescription and print it from the printer of your choice, click Print

.

n To save the single-medication prescription and print it from your default printer, click Quick

Print .

n To save the prescription, and print it later, click Save .

Note: To print a saved prescription later in the day, navigate back to the

Medications and Allergies window, and then click Print All .

Regardless of the method of distribution you choose, the prescription is always recorded in the
patient’s medical summary, and in the patient’s active medications list on the Medications and
Allergies window.

When you print a prescription, a table of the patient’s active allergies is included on the
prescription. You can also choose if your prescription print-outs are to include patient medication
lists by default. Users with administrator authority can enable or disable this option for you. See
"Setting prescription printouts to include patient medication lists by default" on page 87.

Prescribing multiple medications

If you prescribe or refill more than one medication during a visit, you can print the medications on a
single prescription printout.

As you prescribe medications, the EMR lists the medications in the patient’s Active Medications list
in bold text. This way, you can track what prescriptions were created today. When you go to print or
send the prescriptions, you can select what medications are to be included in the prescription print-
out.

Steps

1. Prescribe the first medication. See step 3 to step 13 in "Creating prescriptions" on page 5.

2. Perform one of the following actions to prescribe the next medication:
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n To prescribe a medication that was not previously prescribed to the patient, click Save and

New . The EMR saves the previous medication and displays the medication search.
Prescribe the next medication. See step 3 to step 13 in "Creating prescriptions" on page 5.

n To prescribe a medication that the patient was previously prescribed, click Save and
then refill the medication. See "Refilling or editing a single prescription" on page 59.

3. To add additional medications to the prescription, repeat the above step.

Note:
You can track the medications you prescribed during this visit in the patient’s Active
Medications list. All medications that were prescribed today display in bold text.

4. To print the prescription:

a) Click Print All . The Select Prescriptions to Fulfill window opens, with a list of the
medications you or other providers prescribed, refilled and discontinued today.
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b) To remove medications from the prescription print-out, clear the check box beside the
medication name.

c) Medications that were discontinued today are listed but are not selected to be included on
the printout. To include a discontinued medication on the printout, select the check box
beside the medication name.

d) To print a medication list for the patient’s reference, select Also Print Reference Report.
See "Printing an Rx Reference Report (medication summary list)" on page 38.

e) If you want the patient’s complete list of active medications to display on the prescription
print-out, select the Print Medications check box (if it is not already selected).

f) If your clinic has more than one clinic location, in the Location to print on Rx list, select
your current location.

g) If you want to select a different pharmacy than specified in the individual prescriptions,
select one in the Pharmacy Override list. If the pharmacy does not appear in the list, click

the icon to search for or add it.

h) Perform one of the following actions:

n To go back to the Medications and Allergies window without printing, click Close.

n To view a PDF preview of the final prescription printout, click Preview.

n To print the prescription from your default printer, click Quick Print.

n To print the prescription from the printer of your choice, click Print.

5. To save the prescription, and print it later today, click Save .
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Note: To print a saved prescription later in the day, navigate back to the Medications

and Allergies window and click Print All . See "Re-printing prescriptions" on
page 37.

Prescribing compound medications

View video tutorial:
Prescribing compounds

If the video does not play, Click here to copy the web address and then paste it into a
web browser outside the Wolf EMR data centre.

Compound medications are comprised of two or more ingredients that are combined by a
pharmacist before dispensing. The multitude of potential compound ingredient combinations are not
available in the Wolf EMR's drug database. For this reason, when you prescribe a compound
medication, you must free type compound names and ingredients.

Important : Because the EMR cannot recognize free-typed medication names, when
you prescribe compound medications, you do not receive interaction warnings.

Steps

1. Open the Medications and Allergies window: On any window related to the patient (including a
SOAP note or the medical summary), right-click and choose View Medication List.

2. At the top of the window, click New Compound . A compound prescription entry area
opens.

3. In the Compound Contents text area, enter the compound ingredients.

4. (Optional) In the Compound Name field, type a name for the compound medication.. This name
is printed on the prescription.

5. In the Prescription SIG Directions and Refill Details areas, enter dose, frequency, duration, and
quantity information similar to how you would for basic prescriptions. See step 11 in "Creating
basic prescriptions" on page 6.
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6. In the Other Directions area, type any additional application and dosage directions.

7. Print or save the prescription. See step 11 in "Creating basic prescriptions" on page 6.

Prescribing PRN (take-as-needed) medications

When you prescribe a PRN (take-as-needed) medication, for example, a pain medication or an
inhaler, you do not need to specify a duration as long as you enter a quantity. You must, however,
specify a dose, route, and frequency (unless the prescription type is adjust-as-directed). In the Other
Directions area, you can also enter detailed information such as:

n In what situations or cases patient is to take the medication

n What dose should be administered depending on the situation

n The maximum amount of medication the patient can take in a day

n The minimum amount of time required between doses
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Steps

1. Start a prescription similar to how you would a basic prescription. See step 1 to step 11 in
"Creating basic prescriptions" on page 6. For PRN prescriptions, in the Prescription SIG
Directions area:

a) Select the PRN check box.

b) Enter the dose, frequency, and optionally duration details in the fields provided.

c) In the Frequency list, if none of the options are appropriate, select OTH (other) and then, in
the Other Frequency field, enter the frequency. For example, you can enter “Up to 8x/day”.

d) In the Other Directions area, enter any explicit directions on when to take the medication.
For example, you can enter “Take 15 min prior to exercise”.

Tip:
If you want to enter prescription directions using free-text, instead of using the dose,
frequency, and duration fields, in the prescription type list, select Adjust as Directed.
You can now enter the prescription directions in the Other Directions area.

You are still required to enter a quantity.
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2. If you did not enter a duration, in the Dispense Quantity field, enter a quantity. The EMR cannot
calculate a quantity without duration information.

3. Print or save the prescription. See step in "Creating basic prescriptions" on page 6.

Creating concurrent dose prescriptions

View video tutorial:
Prescribing multiple doses

If the video does not play, Click here to copy the web address and then paste it into a
web browser outside the Wolf EMR data centre.

Concurrent doses are used when a patient is to take different doses of the same medication
concurrently. For example, you can instruct a patient to take 2 capsules of Tylenol in the morning, and
1 capsule at night, or you may instruct a patient to take 3 tablets of Warfarin every-other-day, and 4
tablets of Warfarin every-other-day (on the days between).
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Steps

1. Start a prescription, and search for and select the medication you want to prescribe. See step 1
to step 4 in "Creating basic prescriptions" on page 6.

2. In the Prescription SIG Directions area, in the prescription type list, select Concurrent. The
prescription entry area changes to enable multiple dosage lines for concurrent prescriptions.

3. Enter the first set of Dosing, Frequency, and Duration instructions. For example, 2 tablets in the
morning for 10 days. See step 11 in "Creating basic prescriptions" on page 6.

4. Perform one of the following actions:

n To add another dose line below the first dose line, click .

n To add another dose line above the first dose line, click .

5. Enter the next set of Dosing, Frequency, and Duration instructions. For example, 1 tablet in the
evening for 10 days.
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Note: The word AND displays between the two dosage lines. This indicates that the
two doses are to be taken simultaneously.

6. To enter additional dose lines, repeat step 4 and step 5.

7. In the Dispense Quantity field, enter a dispense quantity, or to have the EMR calculate the

quantity, click .

8. In the Refills field, enter the number of refills.

9. Print or save the prescription. See step 13 in "Creating basic prescriptions" on page 6.

Creating sequential dose prescriptions

View video tutorial:
Prescribing multiple doses

If the video does not play, Click here to copy the web address and then paste it into a
web browser outside the Wolf EMR data centre.

Sequential dose prescriptions are used when a patient is to take different doses between days or
between weeks, but not necessarily in a patterned manner. For example, If you prescribe prednisone
to treat an allergic reaction, you can instruct the patient to take a high dose for several days, and then
progressively reduce the dosage over several days.

Important :
When creating prescriptions that use STAT as the frequency for the first dosage, the
dispense quantity and next refill date are calculated to take in account today's (STAT)
quantity. Move your mouse over the calculate button to see a description of the
calculation.

If you want the patient to start the first STAT dosage in the morning, and the next dosage
in the afternoon, you must manually adjust the dispense quantity.

Steps

1. Start a prescription, and search for and select the medication you want to prescribe. See step 1
to step 4 in "Creating basic prescriptions" on page 6.
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2. In the Prescription SIG Directions area, in the prescription type list, select Sequential. The EMR
displays a prescription entry area that enables multiple dosage lines to be added for sequential
prescriptions.

3. Enter the first set of Dosing, Frequency, and Duration instructions. For example, 2 tabs BID for
one day. See step 11 in "Creating basic prescriptions" on page 6.

Note: You can enter a frequency of STAT only in the first line.

4. Perform one of the following actions:

n To add another dose line below the first dose line, click .

n To add another dose line above the first dose line, click .

5. Enter the next set of Dosing, Frequency, and Duration instructions. For example, 1 tablet TID for
one day.

The word THEN displays between the two dosage lines. This indicates that the patient is to
complete the first dosage instructions, then move onto the next.

6. To enter additional dose lines, repeat step 4 and step 5.
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7. In the Dispense Quantity field, enter a dispense quantity, or to have the EMR calculate the

quantity, click .

8. In the Refills field, enter the number of refills.

9. Print or save the prescription. See step 13 in "Creating basic prescriptions" on page 6.

Creating variable dose prescriptions

View video tutorial:
Prescribing multiple doses

If the video does not play, Click here to copy the web address and then paste it into a
web browser outside the Wolf EMR data centre.

Variable dose prescriptions are used when a patient is instructed to reduce or increase doses
between days or weeks in a step-wise manner. For example, if you are weaning a patient off of
prednisone, you can indicate that the patient is to reduce their daily intake, by a set amount each
week. For variable dose prescriptions, you enter an initial dose and final dose, and then indicate how
much the medication should increase or decrease at each step. Based on this information, the EMR
creates all of the dosage lines for you.

In the medical summary and medication history, variable dosage prescriptions display VARIOUS as
the dosage.

Steps

1. Start a prescription, and search for and select the medication you want to prescribe. See step 1
to step 4 in "Creating basic prescriptions" on page 6.

2. In the Prescription SIG Directions area, in the prescription type list, select Variable. The EMR
displays a prescription entry area that enables details to be added for a patterned dosage
change.

3. In the Initial Dose field, enter the daily dose that the patient is to start at. For example, 8 tablets.

4. In the Final Dose field (to the right of the Initial Dose field), enter the daily dose that the patient is to
finish at. For example, 0 tablets.

5. In the Vary By field, enter the amount the daily dose is to increase/decrease with each change.
For example 1 (tablet).

6. In the Duration field, enter the duration for each dosage step. For example, 1 week.
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7. If the patient is starting the prescription on a day other than today, in the Start Date calendar,
double-click the start date.

8. Click Calculate . The EMR displays multiple dosage lines with most of the fields populated.

9. Modify text or selections in any of the dosage line fields as needed. For example, you can modify
the frequency.

10. In the Dispense Quantity field, enter a dispense quantity, or to have the EMR calculate the

quantity, click .

11. In the Refills field, enter the number of refills.

12. Print or save the prescription. See step 13 in "Creating basic prescriptions" on page 6.
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Creating adjust-as-directed prescriptions

Adjust-as-directed prescriptions are used when a patient requires regular changes in dosage
directions based on their monitored state. For example, if you have a patient on Warfarin, you
regularly provide the patient with new directions based on their INR lab results.

When you create an adjust-as-directed prescription you can enter more general instructions without
completing the standard dosage fields.

Steps

1. Start a prescription similar to how you would a basic prescription. See step 1 to step 4 in
"Creating basic prescriptions" on page 6.

2. In the prescription type list, select Adjust as Directed. The prescription detail entry area opens
with no dosing, frequency or duration fields.

3. In the Other Directions text area, enter your general instructions to the patient.

4. In the Dispense Quantity field, enter the amount of medication you want the pharmacy to
dispense.

Note: The EMR cannot calculate the dispense quantity for adjust-as-directed
prescriptions.
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5. In the Refills field, enter the number of refills.

6. Print or save the prescription. See step 13 in "Creating basic prescriptions" on page 6.

Prescribing medical devices and other non-medication treatments

View video tutorial:
Prescribing non-medication treatments

If the video does not play, Click here to copy the web address and then paste it into a
web browser outside the Wolf EMR data centre.

When you create a prescription for a medical device or another non-medication treatment, you do not
have to search for the treatment as you do for medications, unless you have created a customized
medication for the treatment (see the tip below). Instead, you can free-type the device or treatment
name in the Rx area.

Note: Because the EMR cannot recognize free-typed medication names, when you
prescribe non-medication treatments, you do not receive interaction warnings.

Steps

1. Open the Medications and Allergies window: On any window related to the patient (including a
SOAP note or the medical summary), right-click and choose View Medication List.

2. At the top of the window, click New Override . The prescription entry area displays with an
editable Override Rx area, and Adjust as Directed selected as the prescription type.

3. In the Override Rx field, enter the name of the device, therapy, or other treatment.

4. Perform one of the following actions:

n If you do not want to enter dosage details, in the prescription type list, leave Adjust as
Directed selected.

n If you want to include dosage details, in the prescription type list, select Simple, and then
enter information in the Dosing, Frequency, and Duration fields. See step in "Creating basic
prescriptions" on page 6.

5. In the Other Directions area, enter any additional directions. For example, if the prescription is for
physiotherapy, you can enter “For rehab following ACL repair in the right knee”.
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6. In the Dispense Quantity field, enter a quantity. If you are creating a prescription for a general
therapy or device, where a quantity is not appropriate, enter 1 EA.

7. Print or save the prescription. See step 13 in "Creating basic prescriptions" on page 6.

Recording medications (without prescribing)

View video tutorial:
Recording medications without prescribing

If the video does not play, Click here to copy the web address and then paste it into a
web browser outside the Wolf EMR data centre.

If you want to record that a patient is taking, or has previously taken, a medication but you do not want
to prescribe the medication at this time, you can record the medication as an external medication.
When you record external medications, you are not required to enter any details about the dose,
frequency, duration, and so on, however you can record this information if you choose. You are only
required to search for and select the medication, or to manually enter the medication name if it is a
compound.
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Note: If you are a front-end staff member, you can record medications without requiring
provider approval.

Note: You cannot print external medications as prescriptions. If you want print a
prescription for a medication recorded as External or as an Information Rx, you must
refill the prescription and then print it. See "Refilling prescriptions" on page 59.

Steps

1. Open the Medications and Allergies window, and then search for and select the medication (see
step 1 to step 3 in "Creating basic prescriptions" on page 6). If the medication is a compound,
enter the compound name (see step 1 to step 4 in "Prescribing compound medications" on
page 20).

2. Perform one of the following actions:

n If you want to record the medication without including prescription details, in the Prescription
SIG Directions area, in the prescription type list, select External. The EMR hides the dosing,
frequency, duration, and quantity fields, and selects the Information Rx check box.

Optionally, in the Other directions area, enter any prescription directions or notes.

n If you want to record the patient’s current dosage directions with the medication, select the
Information Rx check box, and then enter the prescription details as if you were prescribing
the medication (see "Creating prescriptions" on page 5).
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Note: When you select Information Rx, most prescription detail fields are
optional. You can record information in as many or as few of the fields as you
please.

3. Perform one of the following actions:

n To save the medication and record another medication, click Save and New .

n To save the medication, click Save .

Managing medication interaction warnings

When you prescribe or refill a medication, the EMR checks the medication against the Cerner Multum
database for:

n Drug-to-allergy interactions (with allergies and intolerances listed in the patient’s active allergies)

n Drug-to-drug interactions (with drugs listed in the patient’s active medications list)

n Drug-to-condition interactions (with conditions listed in the patient’s problems list)

Best practice: If a patient is no longer taking a medication, but the medication is listed
in the patient’s Active Medications list, always discontinue the medication. This way, you
will not receive interaction warnings against irrelevant medications.

Important : The EMR does not check for high or low dosages. For example, if you
prescribe a medication dose that is too high for the patient’s weight or age, you are not
notified.

If any interactions are found, you may be prompted with a pop-up warning. You can configure the
EMR to not display pop-up warnings, and instead allow you to manually check for interaction
warnings. You can also configure the EMR to not check for interactions at all. See "Re-printing
prescriptions" on page 37.

When you receive an interaction warning, the EMR lists a summary of drug interactions and then
provides full details about the interactions.
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Steps

1. If your EMR is configured to not display interaction warnings as pop-up notifications, after you
search for and select a medication to prescribe, at the top of the Medications and Allergies

window, click Interactions . If interactions are found, the EMR opens the Drug Interaction
Warning(s) window, containing a list of all identified interactions, followed by complete details
about the interactions. If your WorkDesk is configured to display interaction notifications
automatically, as soon as you select a medication to prescribe, if the EMR identifies any
interactions, the EMR opens the Drug Interaction Warning(s) window.

If no interactions are found, the message “No interactions found” appears.

2. Using the following table, manage any interaction warnings.
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To do this... Complete the following steps...
Continue to prescribe the
medication despite the warning(s)

Perform one of the following actions:

n To record a reason for continuing with the
prescription, in the Override Reason (optional)
field, enter your reason, and then click Apply.

n If you do not want to enter an override reason,
close the Drug Interaction Warning(s) window.

You can now continue on with the prescription.

Prescribe an alternative medication 1. Close the Drug Interaction Warning(s) window.

2. Above the Rx area, click Back . The EMR
displays the Search Criteria area. You can now
search for a new medication to prescribe.

Discontinue the medication that
interacts with the medication you are
prescribing

1. Close the Drug Interaction Warning(s) window.

2. In the left pane, in the Active Medications list,
click the medication you want to discontinue.
The EMR displays a dialog box with the
following message: “This medication has not
been saved. Close the current medication?”

3. Click Yes.

4. You can now discontinue the prescription for the
interacting medication. See "Discontinuing
medications" on page 51.

Remove an allergy or intolerance
from the patient’s Active Allergies list
(for example, because the allergy or
intolerance is unsupported, or was
recorded in error)

1. Close the Drug Interaction Warning(s) window.

2. In the left pane, in the Active Allergies list, click
the allergy you want to refute. The EMR displays
a dialog box with the following message: “This
medication has not been saved. Close the
current medication?”

3. Click Yes.

4. You can now refute the allergy. See "Refuting
allergies and intolerances" on page 103.

Stop the prescription 1. Close the Drug Interaction Warning(s) window.

2. Close the Medications and Allergies window.
The EMR displays a dialog box with the
following message: “This medication has not
been saved. Close the current medication?”

3. Click Yes.
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4. If you entered and applied an override reason, but want to add another reason:

a) At the top of the Medications and Allergies window, click Interactions . The EMR
opens the Drug Interaction Warning(s) window.

b) In the Override Reason (optional) area, enter your reason, and then click Apply.

c) Close the Drug Interaction Warning(s) window.

After the prescription is saved. The EMR displays any interaction warnings along with your over
ride reason(s) in the Current Medication detail tab for the medication. See "Viewing patient
medications" on page 47.
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Re-printing prescriptions

View video tutorial:
Reprinting prescriptions

If the video does not play, Click here to copy the web address and then paste it into a
web browser outside the Wolf EMR data centre.

If a patient loses or forgets their prescription, you can re-print the original prescription at any time
using the Print All option at the top of the Medications and Allergies window.

Steps

1. Open the Medications and Allergies window: On any window related to the patient (including a
SOAP note or the medical summary), right-click and choose View Medication List.

2. Click Print All . The Select Prescriptions to Fulfill window opens.

3. At the top of the Window, in the Date field, enter the date that the original prescription was
created, or to select a date from a calendar, click the down arrow. A list of medications prescribed
on the selected date is displayed. If the prescriptions were printed, “Printed” is displayed in the
Status column.

Tip: In the Status column, you can view at-a-glance if the listed prescriptions were
printed.
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4. To remove any medications from the prescription print-out, clear the check box beside the
medication name.

5. If your clinic has more than one clinic location, in the Location to print on Rx list, select your
current location.

6. To print a medication list for the patient’s reference, select Also Print Reference Report. See
"Printing an Rx Reference Report (medication summary list)" below.

7. If you want the patient’s complete list of active medications to display on the prescription print-
out, select the Print Medications check box (if it is not already selected), otherwise, clear this
check box.

8. If you want to select a different pharmacy than specified in the individual prescriptions, select one

in the Pharmacy Override list. If the pharmacy does not appear in the list, click the icon to
search for or add it.

9. Perform one of the following actions:

n To view a PDF preview of the final prescription printout, click Preview.

n To print the prescription from your default printer, click Quick Print.

n To print the prescription from the printer of your choice, click Print.

n To go back to the Medications and Allergies window without printing, click Close.

Printing an Rx Reference Report (medication summary list)

If you want to provide a patient with a list of the medications you are prescribing for a visit, or with a
complete list of their active medications, from the Medications and Allergies window, you can print
an Rx Reference Report. An Rx Reference Report contains a list of a patient’s medications and active
allergies and looks similar to a prescription, however, the text Rx Reference Report, This is NOT a
Prescription displays in the letterhead of the report. Rx Reference Reports also contain less detail
than actual prescriptions. For example, they do not include any instructions to the pharmacist.
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Steps

1. Open the Medications and Allergies window: On any window related to the patient (including a
SOAP note or the medical summary), right-click and choose View Medication List.

2. Above the Active Medications list, select the Multiple Rx Actions check box.

3. In the Active Medications list, select the check box beside each of the medications you want to
include in the report, or to select all active medications at once, select the Active Prescriptions
check box.

4. Click Print Reference Report . A preview of the report opens.
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5. Click one of the following options:

n Print : To print or fax the Rx Reference Report on a selected printer.

n Quick Print : To print the Rx Reference Report on your default printer.

Medication favourites

If you prescribe certain medications frequently, you can add these medications as favourites. When
you prescribe favourite medications, you can simply choose the medication in your favourites list and
the EMR populates the prescription directions automatically. You can then make modifications to the
prescription directions as needed before printing the prescription.

Medication favourites also enable you to reduce the amount of time it takes to produce prescriptions
with long or complicated details (for example, tapering medications and compound medications).

You can make medication favourites for yourself, or you can make medication favourites that any
prescriber in the clinic can use.

Note: Favourites can include only one medication. You cannot create a favourite that
includes multiple medications.

You can add a medication favourite using the following methods:

n As you are in the process of writing a prescription for a patient (see "Adding favourites when
prescribing medications" below)

n Based on a previously prescribed medication (see "Adding favourites based on previously
prescribed medications" on the next page)

n From scratch, before you prescribe the medication to a patient (see "Adding favourites for
medications that were not yet prescribed" on page 42)

Adding favourites when prescribing medications

When you create a prescription, you can add the prescription to your list of favourites at any time
during the process. The selected medication, as well as any prescription directions you have entered
are saved as part of the prescription favourite.

Steps

1. Create the prescription for a patient. See "Creating basic prescriptions" on page 6.
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2. Before you print or save the prescription, at the top of the window, click Add to Favourites ,
and then select one of the following options:

n My Favourites : To create a favourite for your use only.

n Clinic Favourites : To create a favourite that can be used by any prescriber in the clinic.

The Add Favourite window opens.

3. In the text area, enter a short description for the favourite.

Note: The description you enter can be searched when selecting a medication to
prescribe. For example, if you include the word Diabetes in the description for a
metformin favourite, when you search for a medication and you enter the word
“Diabetes”, the metformin favourite displays.

4. Click Save. The medication is added to the favourites list.

5. Continue on with the prescription.

Adding favourites based on previously prescribed medications

If a patient has been prescribed a medication, from the patient’s Medications and Allergies window,
you can save the prescription as a favourite.
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Steps

1. Open the Medications and Allergies window: On any window related to the patient (including a
SOAP note or the medical summary), right-click and choose View Medication List.

2. In the Active Medications or Inactive Medications list, click the medication you want to add to
your favourites. The medication’s prescription directions display in the right pane.

3. Add the medication as a favourite. See step 2 to step 4 in "Adding favourites when prescribing
medications" on page 40.

Adding favourites for medications that were not yet prescribed

If there are complex prescriptions you want available as favourites before you prescribe them, you
can create the favourites from scratch from the Manage Medication Favourites window.

Steps

1. Open the Medications and Allergies window: On any window related to a patient (including a
SOAP note or the medical summary), right-click and choose View Medication List.

2. At the top of the window, click Manage . The Manage Medication Favourites window opens.

3. Click New . The medication Search Criteria area displays in the right pane.

4. Search for the medication you want, and then enter the prescription directions as if you are
prescribing the medication:

n For basic prescriptions, see "Creating basic prescriptions" on page 6.
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n For compound prescriptions, click New Compound , and then enter the compound
name and prescription directions. See "Prescribing compound medications" on page 20.

n For PRN prescriptions, see "Prescribing PRN (take-as-needed) medications" on page 21.

n For concurrent dose prescriptions, see "Creating concurrent dose prescriptions" on page 23.

n For sequential dose prescriptions, see "Creating sequential dose prescriptions" on page 25.

n For variable dose prescriptions, see "Creating variable dose prescriptions" on page 27.

n For adjust-as-directed prescriptions, see "Creating adjust-as-directed prescriptions" on
page 29.

n For non-medication treatments, see "Prescribing medical devices and other non-medication
treatments" on page 30.

5. In the Notes area, typea short description for the favourite.

6. Click Save and then, in the list, select one of the following options:

n Save As My Favourite : To create a favourite for your use only.

n Save As Clinic Favourite : To create a favourite that can be used by any prescriber in the
clinic.

Creating prescriptions using favourites

If you have user-specific or clinic-wide medication favourites created, when you prescribe a
medication, a list of your favourites displays in the Search Criteria area. Compound medication
favourites display as a separate list below other medication favourites. In the list of favourites, you
can double-click a favourite to prescribe it. If your list of favourites is extensive, you can filter the list by
entering a search term in the Medication field.

Steps

1. Open the Medications and Allergies window: On any window related to the patient, (including a
patient’s medical summary or SOAP note), right-click and choose Enter New Medication. The
Medications and Allergies window opens, with the medication Search Criteria area displayed.

2. If the Medications and Allergies window is already open, click New Medication to display
the Search Criteria area.

Your Drug Favourites and Compound Favourites are listed in the middle of the Search Criteria
area.
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3. In Search Criteria area, in the Medication field, enter part or all of the favourite medication name or
description. The EMR filters both your Drug Favourites and Compound Favourites lists to
display only medications that match your search term.

4. Double-click the favourite you want. The EMR displays the Prescription SIG Directions area, with
information pre-populated.

5. Modify the prescription directions as needed. See step 11 in "Creating basic prescriptions" on
page 6.

6. Print or save the prescription. See step 13 in "Creating basic prescriptions" on page 6.

Managing your medication favourites

If you created a medication favourite you can modify the favourite’s prescription directions, or remove
the favourite from your favourites list.

Note: Only users with administrator authority can remove or modify clinic-wide
medication favourites.

Steps

1. Open the Medications and Allergies window: On any window related to the patient (including a
SOAP note or the medical summary), right-click and choose View Medication List.
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2. At the top of the window, click Manage . The Manage Medication Favourites window, opens
and displays a complete list of your favourites and the clinic’s favourites. Favourites for
compound medications are listed under Compound Favourites.

3. Click the favourite you want to edit or remove. The EMR displays the favourite’s prescription
directions on the right.

4. To edit the favourite’s prescription directions, edit the information as needed, and then click Save.

5. To change the favourite from a user favourite to a clinic favourite and vice versa, in the right pane
click Save and then, in the list, choose to either Save As My Favourite or Save As Clinic
Favourite.

6. To remove the favourite from your list, click Delete .

7. When you are done, close the Manage Medication Favourites window.

Upgrading favourites added using the old Wolf EMR prescriber

When your clinic is first upgraded to the new Wolf EMR prescriber, you may notice that you can no
longer use some of the prescription favourites you created in the old prescriber. Don’t worry, your
favourites have not been lost. You can manually upgrade these favourites so they can be used in the
new prescriber.

Steps

1. Open the Medications and Allergies window: On any window related to the patient (including a
SOAP note or the medical summary), right-click and choose View Medication List.
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2. At the top of the window, click Manage . The Manage Medication Favourites window opens
and displays a list of your favourites and the clinic’s favourites.

3. To view any unrecognized favourites that were created using the old prescriber, in the list of
favourites, expand Historical Favourites.

4. To delete any unwanted old favourites, click the favourite, and then click Delete .

5. Perform one of the following actions:

n To convert only one historical favourite (for example, if you want to upgrade only your personal
favourites and not the clinic-wide favourites), click the favourite, and then click Upgrade

Favourite .

n To convert all historical favourites at once, click Auto-Upgrade . The EMR converts
most historical favourites to a form that can be used in the new prescriber. If some of your
favourites cannot be auto-upgraded, they remain in the Historical Favourites list. You can

upgrade these favourites one-at-a-time by clicking Upgrade Favourite .

6. If a favourite you are upgrading is for a medication that is no longer available on the market or for a
medication that is not recognized, the EMR displays a dialog box with the following prompt:
“Drug is Inactive do you wish to discontinue Favourite?”. Perform one of the following actions:

n To change the medication used for the favourite, click Yes. The medication Search Criteria
area displays. You can now search for and select a medication for the favourite.

n To keep the favourite as-is with the inactive medication, click No.
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7. To modify an upgraded favourite (for example, if you want to add instructions, or modify dosage
details):

a) In the list of Medication favourites, click the upgraded favourite. The medication favourite’s
Prescription SIG Directions displays in the right pane.

b) Modify the prescription directions as needed.

c) Click Save and then, in the list, select one of the following options:

n Save As My Favourite: To save the favourite as a personal favourite that only you can
use.

n Save As Clinic Favourite: To save the favourite as a clinic-wide favourite that any
prescriber can use.

8. When you are done, close the window.

Viewing patient medications

When you create or modify a prescription for a patient, in the Medications and Allergies window, you
can view at-a-glance the patient’s current (active) and previous (inactive) medications. For each
medication, you can view:

n The current prescription directions

n A history of refills and prescription direction edits for the medication

You can also view any recorded allergies for the patient (see "Viewing patient allergies and
intolerances" on page 93).

Steps

1. Open the Medications and Allergies window: On any window related to the patient (including a
SOAP note or the medical summary), right-click and choose View Medication List. The
Medications and Allergies window opens with the patient’s active medications displayed in the
left pane.
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If a listed medication is crossed out, this indicates that the medication was discontinued and is
no longer available on the market.

2. By default, medications are displayed in chronological order, to re-sort the list, perform one of the
following actions:

n To sort the list by the contents of a column, click the column header. For example, to sort the
list by medication name, click the Drug column header.

n To group the medications by category (Continuous, Short Term, and External), above the list,
in the list, select Categorical.

Users with administrator authority in Wolf EMR can change the clinic’s default view from
Chronological to Categorical and vice versa. See "Modifying prescription window defaults" on
page 81.

3. To view historic medications that the patient is no longer taking, click the Inactive Medications
tab. To go back to viewing the patient’s active medications, click the Active Medications tab.
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Note:
Medications that display on the Active Medications list include:

n Medications that the patient is estimated to be currently or recently taking.
(Based on prescription directions.)

n Continuous medications that were not discontinued (even if the medication is
completed)

4. To view more medication list columns, click and drag the right border of the medication list pane,
or click and drag the pane’s horizontal scroll bar.

5. To view detailed information about a medication and it’s prescription history:

a) In the patient’s Active Medications or Inactive Medications list, click the medication. In the
right pane, the medication’s current prescription directions are displayed.

The current prescription dosage, frequency and duration information is located at the top of
the Current Medication tab. Information regarding the prescription’s print or delivery status,
pharmacy, and more, is located in the Details area.

If there was an interaction warning for the prescription, and the prescriber entered an override
reason for the warning, an additional section displays. You can expand this section to view
the interaction warning(s) and the override reason.

b) To view any collapsed areas (for example, the Other Directions area), click Show Extra

Details .
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c) To view a history of discontinuations, dosage edits and refills for the prescription, at the
bottom of the window, click the Medication History tab.

d) To view the refill history for the prescription, click the Refill History tab.

Note: When a prescription is printed, or refilled, it is documented in the Refill
History.

e) To view any interaction warnings for the medication, at the top of the window, click

Interactions .

Accessing the change log for patient medications

If you want to see a history of changes made to one of a patient’s medications, you can view the
medication log. The log includes information such as who has made changes, what changes were
made, and when the changes were made.

Steps

1. Open the Medications and Allergies window: On any window related to the patient (including a
SOAP note or the medical summary), right-click and choose View Medication List.

2. In the Active Medications or Inactive Medications list, click the medication you want to view a
history for.

3. Click Log .

Modifying patient medications and prescriptions

Once a prescription is created, the medication and it’s prescription history is recorded in the patient’s
chart (first as an active medication, and then later as an inactive medication). From the Active
Medications (and in some cases Inactive Medications) list, you can:

n Discontinue medications (see "Discontinuing medications" on the next page)

n Record adverse reactions to medications (see "Discontinuing medications due to adverse
reactions" on page 53)

n Edit prescription directions (see "Editing prescription dosage directions" on page 55)

n Link a medication to a problem (see "Linking medications to problems" on page 57)
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n Refill prescriptions (see "Refilling prescriptions" on page 59)

n Delete medications (see "Deleting medications" on page 58)

Discontinuing medications

View video tutorial:
Discontinuing prescriptions

If the video does not play, Click here to copy the web address and then paste it into a
web browser outside the Wolf EMR data centre.

When you instruct a patient to stop taking a medication, you should always discontinue the
prescription in the patient’s EMR record. This way, the patient’s active medications list accurately
reflects what medications the patient is currently taking. Also, in keeping a patient’s active
medications list accurate, you will not receive interaction warnings against medications the patient is
no longer taking.

When you discontinue a medication, you have the choice to print a discontinuation report, which can
be sent to the pharmacy.

Note: When a medication is discontinued, it can still be referenced or refilled.
Discontinued medications are never permanently deleted from a patient’s record.

Steps

1. Open the Medications and Allergies window: On any window related to the patient (including a
SOAP note, and the medical summary), right-click and choose View Medication List.

2. Perform one of the following actions:

n To discontinue only one medication, in the Active Medications list, click the medication you

want to discontinue, and then click Discontinue . In the right pane, the EMR displays the
Discontinue Prescription area.
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n To discontinue several medications at once:

a) Above the Active Medications list, select the Multiple Rx Actions check box and then, in
the Active Medications list, select the check boxes beside the medications you want to
discontinue.

b) Click Discontinue . In the right pane, the Discontinue Prescription area displays.

3. In the Reason list, select your reason for discontinuing the medication. If none of the options are
appropriate, select Other and then, in the Comments field, enter your reason.
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Tip: The Reason defaults to Rx no longer required. You can modify the default
reason if required. See "Modifying prescription window defaults" on page 81.

4. To add additional notes regarding your reason for discontinuing the medication, in the
Comments area, enter your notes.

5. To change the discontinue date (for example, if you want the medication to be discontinued next
week), in the Effective Date field, enter a date, or click the down arrow to select a date from a
calendar.

6. Perform one of the following actions:

n To discontinue the selected medication(s), click Save .

n To discontinue the selected medication(s) and prescribe or record another medication, click

Save and New .

n To discontinue the selected medication(s), and print a discontinuation report from the printer

of your choice, click Print .

n To discontinue the selected medication(s), and print a discontinuation report from your

default printer, click Quick Print .

In most cases the EMR removes the prescription(s) from the Active Medications list and displays
the medication in the Inactive Medications list.

Discontinuing medications due to adverse reactions

If a patient has an adverse reaction to a medication, you can discontinue the prescription, and record
the adverse reaction in the patient’s allergies list at the same time.

Steps

1. Open the Medications and Allergies window: On any window related to the patient (including a
SOAP note or the medical summary), right-click and choose View Medication List.

2. In the Active Medications list, click the medication you want to discontinue, and then click

Discontinue . In the right pane, the EMR displays the Discontinue Prescription area.

3. In the Reason list, select Allergy.
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4. Optionally, in the Comments area, enter any additional reasons why you are discontinuing the
medication. You do not have to enter any details about the allergic reaction, as you will soon be
provided another entry window to record this information.

5. Click Save . The Add Drug Allergy area displays, with the medication already selected as the
allergen.

6. Using the following table, record the allergy details.
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Field Description

Intolerance Select if the reaction is due to an intolerance.

Allergy Select if the reaction is due to an allergy.

Reaction
Type

In the list, select the type of reaction the patient experienced.

If none of the options are appropriate, select Other and then, in the
Comments field, enter the reaction type.

Reaction
Date

Optionally, enter the date the reaction took place.

Tip: You can enter partial dates. For example, you can enter “Jan 2015”

Status In the Status list, select one of the following options:

n Suspected: To indicate that an allergy is suspected but not confirmed.

n Confirmed: To indicate that an allergy is confirmed.

Reported
Date

The Reported Date defaults to today.

If the patient reported the reaction prior to today, enter the reported date. Use
the format DD-MM-YYYY or, or to select a date from a calendar, click the
down arrow.

Severity In the Severity listed, select the level of severity the reaction was.

Comments Enter any additional notes about the reaction.

If in the Reaction Type list, you selected Other, enter the reaction type here.

7. Click Save. The EMR adds the allergy or intolerance to the patient’s Active Allergies list.

Editing prescription dosage directions

View video tutorial:
Editing prescriptions and medications

If the video does not play, Click here to copy the web address and then paste it into a
web browser outside the Wolf EMR data centre.

If you instruct a patient to change their medication dose, but the patient still has a supply of the
medication, using the EMR’s prescription change dosage feature, you can quickly document the
dosage change without refilling the medication. You can modify dosage directions for an active
medication, as long as it was not recorded as an external prescription, was not recorded as an
information Rx, or was not prescribed using the old Wolf EMR prescriber.
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When you modify dosage details using the change dosage feature, the medication’s dosage
changes are documented in the medication’s History Details area, in the Medication History tab.
See "Viewing patient medications" on page 47.

Steps

1. Open the Medications and Allergies window: On any window related to the patient (including a
SOAP note or the medical summary), right-click and choose View Medication List.

2. In the Active Medications list, click the medication you want to edit, and then click Change

Dosage . The prescription opens in the Edit area, with the Dosing, Frequency, prn, and
Other Directions fields available for editing.
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Note: The Pharmacist Instructions field defaults to “Dosage Change Only, DO
NOT FILL.” This is because the edit feature is designed only to note changes to a
patient’s dosage information, not to refill a prescription.

Note: If the field you want to edit is greyed-out, or if you want the edited prescription
to be filled, you must refill the prescription instead. See "Refilling prescriptions" on
page 59.

3. Modify the prescription dose and direction information as needed.

4. Perform one of the following actions:

n To save the edited prescription without printing it, click Save .

n To save the edited prescription and prescribe another medication, click Save and New . If
the next medication you are adding has previously been prescribed to the patient, you can
refill the prescription. See "Refilling prescriptions" on page 59.

n To save the edited prescription and print it from the printer of your choice, click Print .

n To save the edited prescription and print it from your default printer, click Quick Print .

Note: The printed prescription contains the following note beside Instructions to
Pharmacist: “Dosage Change Only, DO NOT FILL”.

Linking medications to problems

If a patient is taking a medication to treat a specific medical problem, from the Medications and
Allergies window, you can link the medication to the problem. You can link medications only to
problems that are already recorded in the patient’s problem list. If a medication is linked to the wrong
problem, you can also modify what problem the medication is linked to.

Steps

1. Open the Medications and Allergies window: On any window related to the patient (including a
SOAP note or the medical summary), right-click and choose View Medication List.
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2. In the patient’s Active Medications or Inactive Medications list, click the medication you want to
link to a problem.

3. At the top of the window, click Link Problem . The Link Medication to Problem area displays
in the right pain.

4. In the Problem List, select the problem you want to link the medication to.

5. Click Save.

Deleting medications

If a prescription is created or a medication is recorded for a patient in error (for example, you create a
prescription in the wrong patient’s record), you can completely delete the medication from the
patient’s list of active medications or inactive medications.

Steps

1. Open the Medications and Allergies window: On any window related to the patient (including a
SOAP note or the medical summary), right-click and choose View Medication List.

2. In the patient’s Active Medications or Inactive Medications list, click the medication you want to
delete.

3. At the top of the window, click Delete . The EMR displays a dialog box with the following
prompt: “Are you sure you want to delete prescription?”
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Note: If the Delete option is unavailable (greyed-out), this means that the selected
medication cannot be deleted. Discontinue the medication instead. See
"Discontinuing medications" on page 51

4. Click Yes. The EMR permanently deletes the medication and it’s prescription history from the
patients list of medications. If the medication was on the Active Medications list, the EMR
removes the medication without adding it to the Inactive Medications list.

Refilling prescriptions

View video tutorial:
Refilling prescriptions

If the video does not play, Click here to copy the web address and then paste it into a
web browser outside the Wolf EMR data centre.

If a patient has previously been prescribed a medication, and the medication is listed in the patient’s
active or inactive medications, you can quickly refill the prescription.

You can refill a prescription for a single-medication or for multiple medications at once. If you refill
prescriptions for multiple medications at once, you cannot modify the prescriptions’ details before
the prescriptions are printed (see "Refilling multiple prescriptions at once" on page 62). If you are
refilling multiple prescriptions, but you want to modify the prescription directions for one or more of
the prescriptions, you must refill the prescription for one medication at a time (see "Refilling or editing
a single prescription" below).

Note: If a prescription was not properly migrated from the old Wolf EMR prescriber, you
cannot refill this prescription. Instead, you are prompted to discontinue the prescription
and to create a new prescription.

Refilling or editing a single prescription

If you refill a prescription for one medication at a time, you can modify the prescription directions (for
example, dose, duration, and frequency) before you print or save the refilled prescription.
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Best practice: Avoid refilling prescriptions that are no longer available on the market
(crossed-out). Instead, discontinue the medication, and then create a new prescription
for an available medication.

For prescription refills, the last selected pharmacy for that prescription is selected by default. If you
change the pharmacy, it remains as the default one for the remainder of the prescription session (until
you close the prescription window).

Steps

1. Open the Medications and Allergies window: On any window related to the patient (including a
SOAP note or the medical summary), right-click and choose View Medication List.

2. In the patient’s list of Active Medications or Inactive Medications, click the medication you want
to refill. The medication’s prescription directions display on the right side of the window.

3. Click Fill/Edit . The prescription detail fields on the right side of the window become editable.
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4. To view the patient’s history of prescriptions, prescription edits, and discontinuations for this
medication, at the bottom of the window, click the Medication History tab.

5. To view the patient’s refill history for this medication, click the Refill History tab.

6. If you want the patient’s complete list of active medications to display on the prescription print-
out, select the Print Medications check box (if it is not already selected), otherwise, clear this
check box.

7. To modify the medication strength, or the prescription’s directions, in the Prescription SIG
Directions area, modify the information as needed. See step 11 in "Creating basic prescriptions"
on page 6.
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Tip: If you are refilling a Variable Rx, Sequential Rx, or Concurrent Rx, you can also
add or delete dosage lines at this point.

8. In the Dispense Quantity field, enter a quantity, or to calculate the quantity based on the dose,

frequency, and duration details, click .

9. Print or save the prescription. See step 13 in "Creating basic prescriptions" on page 6.

Refilling multiple prescriptions at once

If you want to quickly refill several medications at once without changing their original prescription
directions (for example, if you are refilling a patient’s “bubble pack”), you can select which
medications you want to refill, and then refill all selected medications in one click. When you refill
multiple prescriptions at once, you:

n Can refill only medications listed in the patient’s Active Medications list

n Cannot modify any of the prescriptions’ dose, frequency, and quantity details

n Must have the same duration of therapy, and refills for all medications being prescribed

To refill medications listed in the patient’s Inactive Medications list, or to modify the prescription
directions for a medication you want to refill, you must refill each medication one-at-a-time. See
"Refilling or editing a single prescription" on page 59.

Best practice: Avoid refilling prescriptions that are no longer available on the market
(crossed-out). Instead, discontinue the medication, and then create a new prescription
for an available medication.

For prescription refills, the last selected pharmacy for that prescription is selected by default. If you
change the pharmacy, it remains as the default one for the remainder of the prescription session (until
you close the prescription window).

Steps

1. Open the Medications and Allergies window: On any window related to the patient (including a
SOAP note or the medical summary), right-click and choose View Medication List.

2. Above the Active Medications list, select the Multiple Rx Actions check box.

3. Select the check box beside each medication you want to refill, or to:

n Select all displayed medications, select the Active Prescriptions check box.
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n Select all continuous or all short term prescriptions, in the list, select Categorical, and then
select the Continuous or Short Term check box.

4. Click Fill . The Multiple Rx Refill area opens in the right side of the window, with a list of the
medications you are refilling.
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5. If at this point you decide to modify what medications you want to refill, in the Active Medications
list, select or clear the check boxes beside medications you want to add or remove, and then

click Fill . When prompted “These medications have not been saved. Close the current
medications?”, click Yes.

6. If you want the patient’s complete list of active medications to display on the prescription print-
out, select the Print Medications check box (if it is not already selected), otherwise, clear this
check box.

7. In the Refill area, in the Duration of Therapy field, enter the number of days the patient is to take all
listed medications.

8. In the Number of Additional Refills field, enter the number of refills for all listed medications.

Note:
n You cannot enter a unique Duration of Therapy and Number of Additional

Refills for each continuous medication. If you want to enter unique values, you
must refill each medication separately. See "Refilling or editing a single
prescription" on page 59.

n If you have included short term prescriptions in the multi-prescription refill, the
Duration of Therapy and Number of Additional Refills are not applied to the
short term medications. Instead, short term medications use the duration and
refill information from the original prescription.

n Duration of Therapy does not apply to Concurrent, Sequential, and Adjust as
Directed, and PRN prescriptions.

Tip: The Duration of Therapy defaults to 90, and the Number of Additional Refills
defaults to 0. If you are a user with administrator authority in Wolf EMR, you can
change your clinic’s default settings if needed. Default settings are applied to all
clinic users, you cannot have unique settings for each user. See "Modifying defaults
for specific medications" on page 84.

9. If your clinic has multiple clinic locations, in the Location list, select the location you are working
out of.

10. Print or save the prescription. See step 13 in "Creating basic prescriptions" on page 6.
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Queued prescriptions and refill requests

Residents, nurses, medical office assistants (MOA), or other staff members who aid providers in
creating prescriptions or who manage refill requests from pharmacies can “queue” prescriptions for
providers—that is, create and submit prescriptions to providers for review. When you queue
prescriptions, you create and refill prescriptions similar to how a provider does. When you finish the
prescription, the prescription is added to the provider’s queued prescriptions list, where the provider
can view, modify, and approve (or deny) the prescription.

Providers who are too busy to manually enter a patient’s prescription(s) can instruct a resident, or
other clinical staff member to enter the prescription(s) on their behalf, in advance of or during a patient
visit. Providers can then review the prescription, make modifications as necessary, and then print it.

Using queued prescriptions:

n Nurses and other clinical staff members can create queued prescriptions for providers (see
"Queueing prescriptions for providers" below)

n Nurses and other clinical staff members can manage queued prescriptions (see "Managing
queued prescriptions - queuer workflow" on page 73)

n Providers can receive and respond to queued prescriptions (see "Processing queued
prescriptions and refill requests - provider workflow" on page 68)

You create and manage queued prescriptions from your WorkDesk.

Note: If you use the provider WorkDesk, but you queue prescriptions for other providers
without creating prescriptions from yourself (for example, if you are a resident), a user with
administrator authority in Wolf EMR must enable you to queue prescriptions. See
"Configuring prescription queueing" on page 89. By default, all users who use the front-
end staff WorkDesk can queue prescriptions for providers.

Queueing prescriptions for providers

When you queue a prescription, you create or refill a prescription using the same method a provider
does. When you finish the prescription, the provider is notified and they can then choose to approve,
modify or reject the queued prescription. You can track and manage prescriptions that are approved
or rejected from your workdesk (see "Managing queued prescriptions - queuer workflow" on
page 73).

When a patient has a prescription that is pending within a provider's queue, a Pending Rxs
indicator appears in the patient header within the patient's medical summary, SOAP notes,
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appointments, and in the prenatal CPX. While in the patient's chart, providers can double-click the
icon to view the prescriptions pending review and take appropriate action.

If administrators granted front-end staff users the permission ( Configuration > View > Employees >
Prescribe as Provider check box), you can save and print prescription on behalf of providers.

Steps

1. If you have the patient’s chart open (including the vitals entry window or the medical summary
window), right-click and then, in the SMART menu, choose Enter New Medication.

2. If you do not have the patient’s chart open, and you use the front-end staff WorkDesk:

a) On the WorkDesk, in the Data Entry area, click Refill Request. The Patient Search window
opens.

b) Search for and select the patient.

The Medications and Allergies window opens, with the Search Criteria area displayed. If the

Search Criteria area is not displayed, at the top of the window, click New Medication .

3. If you are queuing a prescription for a medication that the patient has never been prescribed,
search for and select a medication to prescribe. See step 3 to step 2 in "Creating basic
prescriptions" on page 6.

4. If you are prescribing a compound medication, click New Compound , and then enter the
compound ingredients and compound name. See "Prescribing compound medications" on
page 20.
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Tip: If at this point you decide to queue a prescription for a different medication, on

the top right of the Rx area, click Back . The medication Search Criteria area
displays again. You can now search for a new medication to prescribe.

5. If you are queuing a prescription for a medication that the patient has previously been prescribed,
refill the prescription: In the Active Medications or Inactive Medications list, click the medication

you want to refill, and then click Fill/Edit . The EMR displays editable prescription detail fields
on the right side of the window. For detailed information on how to refill prescriptions, see
"Refilling prescriptions" on page 59.

6. In the Prescriber list, select the provider you are queueing a prescription for.

Note: If the provider you want is not available in the list, the provider must be
enabled to receive queued prescriptions. See "Configuring prescription queueing"
on page 89.

7. In the Pharmacy list, select the patient’s pharmacy, or if you do not want to select a pharmacy,
choose <<None>>.

8. If the pharmacy you want is not in the Pharmacy list, or if a pharmacy’s information is incorrect,
you can add or modify pharmacies:

a) Beside the Pharmacy list, click . The Pharmacy Address Book opens.

b) Add or modify pharmacies as needed.

9. If your clinic has more than one location, in the Location to print on Rx list, select your current
location.

10. In the Prescription SIG Directions, and Refill Details area, enter or modify information for the
prescription:

n For basic prescriptions, see step 11 in "Creating basic prescriptions" on page 6.

n For a compound prescriptions, see "Prescribing compound medications" on page 20.

n For PRN prescriptions, see "Prescribing PRN (take-as-needed) medications" on page 21.

n For concurrent dose prescriptions, see"Creating concurrent dose prescriptions" on page 23.

n For sequential dose prescriptions, see "Creating sequential dose prescriptions" on page 25.

n For variable dose prescriptions, see "Creating variable dose prescriptions" on page 27.
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n For adjust-as-directed prescriptions, see "Creating adjust-as-directed prescriptions" on
page 29.

n For non-medication treatments, see "Prescribing medical devices and other non-medication
treatments" on page 30.

11. To print or save the prescription (only if you have the permission), select the Act as Provider
check box and select the provider with whom you are working. The patient's primary provider is
selected by default. Once selected, the print actions are available instead of only the Queue
action. are working with. The provider's name is printed on the prescription. These actions are
recorded in the system audit log.

12. Click Queue . The EMR adds the prescription to your Prescriptions Pending Review list.

Processing queued prescriptions and refill requests - provider workflow

This information applies to providers. If you are front-end staff, see "Managing queued prescriptions
- queuer workflow" on page 73.

If another EMR user queues a prescription for you, you are notified on your WorkDesk. You can view,
edit, approve, and deny queued prescriptions. You can also create a To Come In task for a patient
with a queued prescription before you approve the request.

If you are covering for another provider, you can manage queued prescriptions for that provider, as
long as you have signed-out their Workdesk.

Tip: If patient has a prescription that is pending within a provider's queue, a Pending Rxs

indicator appears in the patient header within the medical summary, SOAP notes,
appointments, and in the prenatal CPX. Within the Medications and Allergies window,
pending medications appear in their own tab. Double-click the icon (or click the tab) to
view the prescriptions pending review and take appropriate action.

Note: You can view and respond to queued prescriptions only if your WorkDesk is
configured to display Prescriptions Pending Review. See "Configuring prescription
queueing" on page 89.

Steps

1. On your WorkDesk, in the Tasks tab > Refill Requests area, click # Prescriptions Pending
Review, where # indicates the number of requests waiting for your review.
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The Prescriptions to be Reviewed window opens and shows a list of patients in alphabetical
order, with un-reviewed queued prescriptions or renewal requests in the left pane and a list of the
patient’s queued prescriptions on the right.

2. In the left panel, under Patient Name, click a patient. The patient’s queued prescriptions appear
on the right pane.

For refill requests initiated by front-end staff:

n The first line indicates the status of the queued medication (see list of icons below), date of
the request, and the provider's name and clinic location (if using multiple locations).

n The second line indicates the medication details.

Status icon Description

no icon Pending; no action was yet taken

Approved

Denied

Patient must come in

Recalled

Tip: To see more information about the requests, such as queue notes, quantity,

refills, last prescribed date, and indication, click View More .

3. To filter the list of patients according to the pharmacy that is requesting a refill or by location if you
have multiple Wolf EMR locations, choose an option in the Filter Options.

4. To view all queued prescriptions managed in the within the last 7 days, select the Historical
Refills Last 7 Days check box.

5. If your EMR is configured to not display interaction warnings as pop-up notifications, you can
check for interaction warnings:
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a) Select a queued prescription and click Interactions . The prescription opens in the
Medications and Allergies window. If any interactions are identified, the EMR also opens
the Drug Interaction Warning(s) window. If no interactions are identified, the message “No
drug hazards found” appears.

b) You can now manage any interaction warnings.

6. Select one or more queued prescription(s) to manage and perform one of the following actions:
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To do this... Do this...
Approve a
prescription
without
modifications

1. Click Approve .

2. If the request was initiated by your staff, no further action is required. The
EMR removes the prescription from your queued prescription list and
notifies the queuing nurse or MOA that the queued prescription is
Approved. The nurse/MOA can now print and fax the prescription report
or call the pharmacy.

Tip: To both approve and print the prescription, click Print
Rx.

The prescription(s) appear(s) in the patient’s list of active medications.
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To do this... Do this...
Edit a queued
prescription
or to print the
prescription

1. Click Edit . The EMR opens the prescription in the Medications
and Allergies window.

2. Modify the prescription as needed.

Tip:

3. Perform one of the following actions:

n To save the edited prescription, and notify your front-end staff that

the prescription is edited and approved, click Save . The EMR
marks the edited prescription as Approved, notifies the front-end
staff, and removes the prescription from your queued prescriptions
list.

Note: If the patient has more than one prescription to
approve, select this option for each prescription. You
can then print or send all prescribed medications on
the same prescription print-out.

n To save the edited prescription, and to prescribe another

medication, click Save and New .

n To print the prescription from the printer of your choice, click Print

.

n To print the prescription from your default printer, click Quick Print

.

Note: No matter which action you perform, the EMR
notifies the queuing nurse or MOA that the status of
the edited queued prescription is Approved.
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To do this... Do this...
Deny a
queued
prescription

1. To deny the prescription without including a note, click Deny .

2. To include a note on why you’re denying the prescription, click Deny

> Deny with Note. Select a reason or to type your own reason,
choose Other.

3. If the request was initiated by your staff, no further action is required. The
EMR removes the prescription from your queued prescription list and
notifies the queuing nurse or MOA that the queued prescription is
Denied. The nurse/MOA now knows to NOT print the prescription and
to inform the pharmacy or patient of the prescription denial.

Indicate to
your front-
end staff that
the patient is
to come in for
a visit

When you choose any of the To Come In options, the status of the
prescription becomes To Come In and the patient is removed from your
Prescriptions Pending Review. The patient is NOT added to the Patients
to Notify list. Perform one of the following:

n To change the prescription status to To Come In, and to produce a

follow-up task, click To Come In . A follow-up task opens, and is
assigned to you by default. Modify the task as needed, and then click

Close & Save .

n To change the prescription status to To Come In, and to include a note

for the front-end staff, click To Come In > With Note.

n To change the prescription status to To Come In, without producing a
follow-up task or adding a note, in the To Come In list, select With No
Follow-up.

If the request was an electronic renewal request, the pharmacy is notified
that the request is under review because the patient needs an appointment.

4. When you are done, close the window.

Managing queued prescriptions - queuer workflow

This information applies to front-end staff who queue prescriptions for providers. If you are a provider,
see "Processing queued prescriptions and refill requests - provider workflow" on page 68.

From the WorkDesk, you can view and manage all of your clinic’s incomplete queued prescriptions.
This includes new prescription or refill requests that were queued for providers by front-end staff (see
"Queueing prescriptions for providers" on page 65). Incomplete queued prescriptions include any
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queued prescriptions that were not yet actioned by providers, or printed/sent, called-in, or removed
by front-end staff. From this list, you can:

n View prescription statuses (approved, declined, or pending) of each queued prescription

n Cancel prescriptions (if they were not approved or declined)

n Indicate that you have called the pharmacy or patient who requested a refill

n Print prescription request reports

n Print prescriptions (if they were approved by a provider)

n Recall a request (if it was created in error)

Steps

1. On the WorkDesk, in the Clinic Tasks area, under Telephone/Fax Refills, click # Prescriptions
Pending Review, where # indicates the number of requests in the queue. The Prescriptions
Pending Review window opens.

2. In the Filter Options area, optionally filter the list of queued prescriptions.

Option Description

All Queued
Rx

Includes all incomplete queued prescriptions.

Approved Includes only approved prescriptions that were not printed or sent.

Denied Includes only declined prescriptions.

To Come In Includes only prescriptions with a status of To Come In (where the provider
has requested that the patient comes in for a visit to receive their refill)

Pending Includes only prescriptions that are still pending a provider's response.
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Option Description

Historical
Refills Last 7
Days

Includes completed queued prescriptions (queued prescriptions that were
printed or sent) within the last 7 days.

Prescriber(s) Shows queued prescriptions for a specific provider.

Location(s) If your clinic has multiple locations, shows queued prescriptions for a
specific location.

3. Select a pharmacy in the left pane. A list of patients who have queued prescriptions from that
pharmacy appears in the right pane.

For refill requests initiated by front-end staff:

n The first line indicates the status of the queued medication (see list of icons below), date of
the request, and the provider's name and clinic location (if using multiple locations).

n The second line indicates the medication details.

Status icon Description

no icon Pending; no action was yet taken

Approved

Denied

Patient must come in

Recalled

Tip: To see more information about the requests, such as queue notes, quantity,

refills, last prescribed date, and indication, click View More .

4. Select a queued prescription to manage and perform one of the following actions:

Note: You cannot recall queued prescriptions that were already actioned by a
provider (approved, denied, or marked for the patient to come in).
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To do this... Do this...
Cancel queued prescriptions (and
remove from the provider's list)

1. Select the queued prescription(s) to remove.

2. Click Recall . The status of the queued
prescription(s) changes to Recalled.

3. Select the recalled prescription(s) and then click

Remove .

Edit a queued prescription 1. Select the queued prescription to edit.

2. Click Recall . The status of the queued
prescription(s) changes to Recalled.

3. Select the recalled prescription and then click

Edit . The prescription opens in the
Medications and Allergies window.

4. Modify the prescription details as needed, and

then click Queue .

Indicate that you notified the
pharmacy by telephone that the
prescription(s) was approved or
denied

1. Select the prescription(s).

2. Click Mark Called .

The prescription(s) are removed from the queue.

Mark Called is available only for Approved or
Denied prescriptions.
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To do this... Do this...
Print a refill request response report
for the pharmacy

1. Select the prescription(s).

2. Click Print List . A preview opens.

3. Click one of the following options:

n Print : To print or fax the report on a
selected printer.

n Quick Print : To print the report on your
default printer.

Printing a refill request response report is available
only for Approved or Denied prescriptions.

Print an approved prescription 1. Click the approved queued prescription.

2. Click Print Rx . A preview opens.

3. Click one of the following options:

n Print : To print or fax the report on a
selected printer.

n Quick Print : To print the report on your
default printer.

Separate prescriptions print for each patient. If the
approved prescription includes multiple
medications, they are included in the same printout.

Configuring medications and prescriptions

You can customize a number of features around medications and prescriptio

ns. You can:

n Set defaults for medication interactions (see "Configuring medication preferences" on the next
page)

n Set defaults for medication search options (see "Configuring medication preferences" on the next
page)

n Set defaults for enabling medication substitutions (see "Configuring medication preferences" on
the next page)
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n Set defaults for the patient active medication list view - chronological vs. categorical (see
"Modifying prescription window defaults" on page 81)

n Modify the prescription detail defaults for all medications (see "Modifying prescription window
defaults" on page 81

n Modify the discontinue medication reason default (see "Modifying prescription window defaults"
on page 81

n Modify the defaults for a specific medication (see "Modifying defaults for specific medications"
on page 84)

n Choose to either include or hide patient medication lists on prescription printouts (see "Setting
prescription printouts to include patient medication lists by default" on page 87)

n Enable and disable prescription queueing for providers and restrict certain users from being able
to queue prescriptions (see "Configuring prescription queueing" on page 89)

Configuring medication preferences

You can configure default medication preferences for searching, enabling substitutions, and
interaction warnings.

Note: Only users with administrator authority in Wolf EMR can set clinic-wide defaults.
Providers can set their own defaults, which overwrite the clinic defaults.

Medication search options

When users prescribe or enter medications in patient charts, you can set what medication search
options are selected by default. You can also choose if medication search matches can include
medications that are similar to the search term, even though they may not start with or contain the
exact text entered.

Enabling substitutions

By default, the option to enable substitutions when prescribing is enabled. You can clear this option.

Interaction warnings

If you create or queue prescriptions, you can control if and how you receive interaction warnings. You
can specify if:

n Interaction warnings are to display as pop-up notifications

n You are to manually check for interaction warnings, without receiving pop-up notifications
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n The EMR is not to check for interactions at all

Default history display

You can choose to have the Refill History tab open by default when you view the patient's medication
instead of the Medication History tab.

Steps

1. From the WorkDesk menu, click Configure > Configure WorkDesk . The WorkDesk User
Preferences window opens.

Tip: For administrators, from the Wolf EMR home page, click Configuration >
Runtime Configuration tab, and then, at the bottom of the window, click WorkDesk
Preferences.

2. Click the Medications tab.

3. To set default medication search options, use the following table to choose an option. If you are
setting preferences for yourself, clear the Apply Clinic Setting check box beside any options you
are modifying.
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To set a default for the following option... Do this...

1 Starts with vs Contains In the Medication search
list, select the option you
want selected by default.

2 Whether medication search matches can include
medication names that are similar to the search term but
don’t necessarily start with or contain the exact search
term

Select or clear the Use
partial match for
medication search
check box.

3 How similar medication names must be to be included
in search matches

In the Degree of similarity
for partial search list,
select a level.

4 Include Generic Select or clear the
Include Generics in
search check box.

5 Include OTC Select or clear the
Include OTC in search
check box.

6 Include IV Select or clear the
Include IV in search
check box.

4. To clear the option to allow substitutions by default when prescribing, clear the Allow
Substitutions Default check box.

5. To set interaction warnings, beside Multum Drug Interaction, clear the Apply Clinic Setting
check box and then, in the list, select one of the following options:
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Option When the EMR identifies interactions...

Always
On

The EMR checks for interactions, and if any are found, you receive a pop-up

notification. When selected, the Interactions icon is not available.

Always
Off

The EMR does not check for interactions, and you receive no warnings. When
selected, you cannot manually check if there are any interaction warnings. The

Interactions icon is not available.

Manual The EMR checks for interactions, but does not notify you automatically. Instead,

you can view any interaction warnings by clicking Interactions .

6. To choose whether to open the Refill History or Medication History tab by default when you view
the patient's medication, select an option in the Default History Display list.

7. Click Save settings and exit .

Modifying prescription window defaults

Users with administrator authority in Wolf EMR can modify the clinic-wide default selections in the
Medication and Allergies window. Each provider can modify their own personal preferences and
override the clinic ones. You can:

n Set defaults for the patient active medication list view - chronological vs. categorical. In the
Medications and Allergies window, a patient’s active medications are listed in chronological
order by default. You can, however, change the clinic-wide default so that active medications are
grouped by category (Continuous, Short Term, and External) instead.

n Modify the prescription detail defaults for medications

n Modify the discontinue medication reason default

Tip: If you resized and changed the layout of the Medications and Allergies window and
the information is no longer legible, you can reset the layout back to it's original size.
From the Maintenance tab, choose Reset Saved Screen Layout.

Steps

1. From the Wolf EMR home page, click the Maintenance tab.

2. From the Maintenance toolbar, in the Rx area, click Configure Preferences . The Rx
Preferences window opens.
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3. Using the following table, modify your prescription defaults.
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Field Description

Default
Medication
View

In the Medications and Allergies window, a patient’s active medications are listed
in chronological order by default. You can change the order to instead group
active medications by category (Continuous, Short Term, and External).

Multiple
Refill

When you refill multiple prescriptions at once for a patient, the Duration of Therapy
defaults to 90, and the Number of Additional Refills defaults to 0. Enter your
preferred values in the Duration of Therapy and Number of Additional Refills
fields.

Discontinue
Rx Reason

When you discontinue a medication for a patient, you are required to select a
reason for discontinuing the medication. Rx no longer required is selected by
default. You can modify the default reason.
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Field Description

Dosing
Form
Options

When you prescribe a medication, the Form/Unit and Dispense Quantity type
units show only units suggested by the Multum database by default. You can
modify this to expand the list and show all units.

4. Click Save.

Modifying defaults for specific medications

For a specific medication, you can set prescription defaults for:

n Dosing

n Anticoagulant designation

n Frequency

n PRN

n Duration

n Other directions

When you prescribe the medication, no matter what strength you choose, prescription detail fields
are populated automatically with the medication’s defaults. You can then edit the prescription details
as needed, and complete the prescription as normal. Medication prescription defaults can save a
significant amount of time as prescribers typically only need to modify one or two fields each time
they prescribe the medication.

Medication prescription defaults apply only to simple prescriptions. They are not applied to
sequential, concurrent, variable, adjust as directed, or external prescriptions. Defaults are set for all
users only. You cannot set different defaults for individual users.

84

Medications and prescriptions



Steps

1. From the Wolf EMR home page, click Configuration .

2. From the Configuration menu, choose View > Patient Reference Tables > Medication Index.
The Medication Maintenance window opens.

3. In the Search tab, in the Medication Name field, type part or all of the mediation name, and then
click Search.

4. In the list of matching medications, click the medication you want to modify. In the Data tab, the
EMR displays the medication’s default settings.

5. Using the following table, modify the medication’s prescription default settings as needed.
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To set a default value
for the following field
in the prescription

Do this...

First Dosing field In the Pill Quantity list, enter the default dose.

Frequency Select the default frequency.

Duration Select either:

n The default number of days or months

n No Cut Off or <None> to not populate the field with a default
number of days or weeks, and to default the prescription as a
continuous prescription.

Note: If you select a specific number of days or weeks,
the prescription defaults to a short term prescription.

PRN check box Select to have the PRN check box selected by default on the
prescription.

Anticoagulation
check box

Select to have the Anticoagulation check box selected by default
on the prescription.

Other Directions In the Instructions area, type the directions you want to display by
default in the Other Directions field of the prescription (for example,
“May be taken any time but evening is recommended”)

New prescriber:
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Legacy prescriber:

6. Click Save Changes .

Setting prescription printouts to include patient medication lists by default

For each user who prescribes medications, you can choose if their prescription printouts are to
include patient medication lists by default.
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When you set medication lists to display on prescription printouts by default, every time the
prescriber creates a prescription, the Print Medications check box is automatically selected.

If the prescriber does not want the medication list to be included on a prescription print-out, they can
choose to clear the Print Medications check box. This setting is user-specific, so you must enable
or disable it for each prescriber individually.

Steps

1. From the Wolf EMR home page, click Configuration .

2. From the Configuration menu, click View > Physicians/Service Providers > Office Service
Providers. The Physicians/Service Providers in Clinic window opens.

3. In the Office Service Provider list, select the provider you want to enable/disable prescription
medication lists for.
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4. In the Other Data tab, in the Prescription Options area, select or clear the Print Medications on
Rx check box.

5. Click Save .

Configuring prescription queueing

You can configure three different aspects of prescription queuing (see "Queued prescriptions and
refill requests" on page 65).

n "Enabling providers to receive queued prescriptions" below

n "Enabling providers to queue prescriptions for other providers" on the next page

n "Restricting users from queueing prescriptions" on page 91

Enabling providers to receive queued prescriptions

If you are a provider, other users can queue prescriptions for you only if your WorkDesk is enabled to
view Prescriptions Pending Review. You can enable your own WorkDesk to view prescriptions
pending review, or if you have administrator authority in Wolf EMR, you can enable all clinic providers
to view them by default.
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Steps

1. Perform one of the following actions:

n If you are enabling queued prescriptions for yourself only, from the WorkDesk menu, choose

Configure > Configure Workdesk .

n If you are enabling queued prescriptions for all providers in your clinic, from the Wolf EMR

home page, choose Configuration > Runtime Configuration tab > WorkDesk
Preferences.

The WorkDesk User Preferences window opens.

2. On the General tab, in the Label Visibility area, beside Prescriptions Pending Review select the
User Setting or Clinic Setting check box.

3. Click Save settings and exit .

Enabling providers to queue prescriptions for other providers

Clinical staff members or providers (such as residents, nurses, medical office assistants (MOA)) can
queue prescriptions for other providers as long as they do not create any prescriptions under their
own name.

A user with administrator authority in Wolf EMR can enable such providers to queue prescriptions for
other providers.

Steps

1. From the Wolf EMR home page, click Configuration .
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2. From the Configuration menu, choose View > Physicians / Service Providers > Office Service
Providers. The Physicians / Service Providers in Clinic window opens.

3. In the Office Service Provider list, select the provider.

4. In the Other Data tab, in the Prescription Options area, select the Non-Prescriber check box.

5. Click Save , and then close the window.

Restricting users from queueing prescriptions

By default, all front-end staff member can queue prescriptions for providers. If you do not want a user,
or a group of users, to queue prescriptions, users with administrator authority in Wolf EMR can create
a security rule for the user or user group and remove their access to create queued prescriptions.

Steps

1. From the Wolf EMR home page, click Configuration .

2. From the Configuration menu, choose View > Security > Security Rules. The Security window
opens with the Security Rules tab selected.

3. In the left pane, click the user or user group you want to restrict and then, at the bottom of the
window, click New Security Rule. The New Security Rule window opens.

4. Using the following table, set a security rule to prevent the user(s) from queuing prescriptions.

91

Medications and prescriptions



Field/area Value

Module Select Medications/Prescriptions.

Rule
allows
user/group
to

Beside each of the actions you do not want the user to be able to perform on
patient medications and prescriptions (Add, Change, Delete, View, and
Print), select No.

5. Click OK and then close the window.
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Allergies and intolerances

From a patient’s medical summary, you can view a basic list of the patient’s allergies and
intolerances. When you click an allergy to view more detailed information, the allergy opens in the
Medications and Allergies window. This window contains a detailed list of a patient’s active and
inactive (refuted) allergies and intolerances (see "Viewing patient allergies and intolerances" below).
From here, you can do the following for a patient:

n Record allergies and intolerances (see "Recording allergies and intolerances" on page 96)

n Modify allergies and intolerances (see "Modifying allergies and intolerances" on page 102)

n Refute allergies and intolerances (see "Refuting allergies and intolerances" on page 103)

n Permanently delete allergies and intolerances (see "Deleting allergies and intolerances" on
page 104)

n View the change history of an allergy or intolerance (see "Accessing the change log for patient
allergies or intolerances" on page 105)

Viewing patient allergies and intolerances

Although you can view a basic list of allergies and intolerances in a patient’s medical summary, you
can view more detailed information about allergies and intolerances only from the Medications and
Allergies window.

Steps

1. Open the Medications and Allergies window: On any window related to the patient (including a
SOAP note or the medical summary), right-click and choose View Medication List. The
Medications and Allergies window opens with the patient’s active allergies displayed in the lower
left pane.
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Note: If you are viewing a patient’s medical summary, and you click an allergy to
view more detailed information, the allergy displays in the Medications and Allergies
window.

2. By default, a patient’s allergies and intolerances display chronologically according to the date
they were reported/refuted/updated, in the following order:

n Drug allergies (DA)

n Drug intolerances (DI)

n Non-drug allergies (NDA)

n Non-drug intolerances (NDI)

Drug-related allergies and intolerances display with red text. To re-sort the list by the contents of a
column, click the column header. For example, to sort the list by how severe the reactions were,
click the Severity column header.

3. To group the allergies and intolerances by category (Drug Allergies, Drug Intolerances, Non-Drug
Allergies, and Non-Drug Intolerances), above the list, select the Group by Category check box.
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4. To view the patient’s refuted allergies and intolerances, click the Inactive Allergies tab. To go
back to viewing the patient’s active allergies, click the Active Allergies tab.

5. To view more allergy list columns, click and drag the right border of the allergy list pane, or click
and drag the pane’s horizontal scroll bar.

6. To view detailed information about an allergy or intolerance, in the Active Allergies or Inactive
Allergies list, click the allergy. In the right pane, the EMR displays the reaction details.
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Recording allergies and intolerances

View video tutorial:
Recording allergies

If the video does not play, Click here to copy the web address and then paste it into a
web browser outside the Wolf EMR data centre.

You can record that a patient has an allergy or intolerance to a:

n Specific drug (see "Recording drug allergies and intolerances" below)

n Non-drug allergen (see "Recording non-drug allergies and intolerances" on page 99)

Also, if the patient has no know allergies or intolerances, you can record this information in the
patient’s chart (see "Recording that a patient has no known allergies or intolerances" on page 101). If
you record that a patient has no know allergies or intolerances, everywhere the patient’s allergies and
intolerances are programed to pull (for example, letters, the prenatal form, and requisition forms) the
statement “No Known Allergies” populates.

Recording drug allergies and intolerances

If a patient has a reaction to a medication, you can record the reaction as an allergy or intolerance.
You can record a reaction only to a specific medication (including strength). You cannot record a
reaction to a general medication group (for example, “penicillins”). The EMR does however recognize
that the patient is allergic to all medications with similar ingredients to the medication you record. For
example, if you select Amoxicillin, the EMR recognizes that the patient is allergic to all penicillins. You
therefore receive interaction warnings for all penicillins.

If you are recording a reaction to a medication that the patient is currently taking, you can discontinue
the prescription and record the reaction at the same time. See "Discontinuing medications due to
adverse reactions" on page 53.

Steps

1. Open the Medications and Allergies window: On any window related to the patient (such as the
medical summary, vitals entry, or SOAP note), right-click and choose New Allergy. The
Medications and Allergies window opens, with the Add Drug Allergy area displayed.
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2. If you already have the patient’s Medications and Allergies window open (for example, if you

have just prescribed a medication), at the top of the window, click Add Drug Allergy . The
Add Drug Allergy area displays.

3. In the Add Drug Allergy area, select the medication the patient had a reaction to:

n If you are recording a reaction to a medication listed in the patient’s active medication list,
select Active Drugs and then, in the list, select the medication.

n If you are recording a reaction to a medication not listed in the patient’s active medication list:

a) Select Search Drug and then, in the entry field, enter part or all of the medication name.

b) Click Search. The EMR displays a list of matching medications.
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Tip: By default, the EMR displays matching medications that Starts with your
search term. To include medications that contain your search term (anywhere in
the name), select Contains.

c) Click the medication, and then click Continue. The Type and Details entry areas display.

4. Using the following table, record the reaction details.

Field Description

Intolerance If the reaction is due to an intolerance, select this option.

Allergy If the reaction is due to an allergy, select this option.

Note: Allergic reactions display in red in the patient’s list of Active
Allergies.

Reaction
Type

Select the type of reaction the patient experienced.

If none of the options are appropriate, select Other and then, in the
Comments field, enter the reaction type.

Reaction
Date

Optionally, enter the date the reaction took place.

Tip: You can enter partial dates. For example, you can enter “Jan
2015”
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Field Description

Status Select one of the following options:

n Unknown: To indicate that the existence of the allergy is unknown.

n Suspected: To indicate that an allergy is suspected but not confirmed.

n Confirmed: To indicate that an allergy is confirmed.

Reported
Date

The Reported Date defaults to today.

If the patient reported the reaction prior to today, enter the reported date. Use
the format DD-MM-YYYY or click the down arrow and select a date from the
calendar.

Severity Select the level of severity the reaction was.

Comments Enter any additional notes about the reaction.

If in the Reaction Type list, you selected Other, enter the reaction type here.

5. Click Save.

Recording non-drug allergies and intolerances

If a patient experiences a reaction to a non-drug allergen such as dander or nuts, you record the
reaction as a non-drug allergy or intolerance.

Steps

1. Open the Medications and Allergies window: On any window related to the patient (including a
SOAP note or the medical summary), right-click and choose View Medication List. The
Medications and Allergies window opens, with the Add Non Drug Allergy area displayed.

2. If you already have the patient’s Medications and Allergies window open (for example, if you have

just prescribed a medication), at the top of the window, click Add Non Drug Allergy . The Add
Non Drug Allergy area displays.

99

Allergies and intolerances



3. Using the following table, enter the reaction details.

Field Description

Agent Enter the allergen. For example, hay or dander.

Intolerance If the reaction is due to an intolerance, select this option.

Allergy If the reaction is due to an allergy, select this option.

Note: Allergic reactions display in red in the patient’s list of Active
Allergies.

Reaction
Type

Select the type of reaction the patient experienced.

If none of the options are appropriate, select Other and then, in the
Comments field, enter the reaction type.

Reaction
date

Enter the date the reaction occurred.

Note: You do not have to use a specific date format. For
example, you can enter “1st week of February”.
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Field Description

Status Select one of the following options:

n Unknown: To indicate that the existence of the allergy is unknown.

n Suspected: To indicate that an allergy/intolerance is suspected but not
confirmed.

n Confirmed: To indicate that an allergy/intolerance is confirmed.

Reported
Date

The Reported Date defaults to today.

If the patient reported the reaction prior to today, enter the reported date. Use
the format DD-MM-YYYY or click the down arrow and select a date from the
calendar.

Severity Select the level of severity the reaction was.

Comments Enter any additional notes about the reaction.

If in the Reaction Type list, you selected Other, enter the reaction type here.

4. Click Save.

Recording that a patient has no known allergies or intolerances

If a patient does not have any allergies or intolerances, you can record this information in the patient’s
chart. If you record that a patient has no known allergies, when you create referral letters, SOAP notes,
consult letters, SMART forms, or any other forms/templates that pull the patient’s allergies, the text
“No Known Allergies” displays whereever allergies are programmed to pull.

Steps

1. Open the Medications and Allergies window: On any window related to the patient (including the
medical summary, Vitals Entry window, or SOAP note), right-click and choose New Allergy.

2. At the top of the window, click No Known Allergies .

Note: If the No Known Allergies option is unavailable (greyed-out), this indicates
that the patient has allergies/intolerances recorded. If the allergies/intolerances
should not be in the patient’s record, you must refute or delete the listed
allergies/intolerances before you can record that the patient has no known allergies.

3. When prompted with : “Reviewed with patient and no known allergies or intolerances exist.” , click
Ok. In the Active Allergies area, the text, No Known Allergies is recorded.

101

Allergies and intolerances



Modifying allergies and intolerances

After you record an allergy or intolerance for a patient, you can later modify the reaction details if
needed. You cannot change an allergy to an intolerance and vice versa. If you want to change an
allergy to an intolerance, refute the allergy (see "Refuting allergies and intolerances" on the next page)
and then re-enter the reaction as an intolerance (see "Recording allergies and intolerances" on
page 96).

Steps

1. Open the Medications and Allergies window: On any window related to the patient (including a
SOAP note or the medical summary), right-click and choose View Medication List.

The Medications and Allergies window opens, with the patient’s active allergies displayed in the
lower left pane.

2. In the Active Allergies list, click the allergy or intolerance you want to modify and then, at the top of

the window, click Modify . The Allergy Details area opens.
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3. Modify details for the allergy or intolerance as needed:

n For drug allergies, see step 4 in "Recording drug allergies and intolerances" on page 96.

n For non drug allergies, see step 3 in "Recording non-drug allergies and intolerances" on
page 99.

Note: You cannot change an allergy to an intolerance and vice versa. If you want to
change an allergy to an intolerance, refute the allergy and then re-enter the reaction
as an intolerance.

4. Click Save.

Refuting allergies and intolerances

If a suspected allergy or intolerance turns out to be false, you can refute it. When you refute allergies
and intolerances, they are moved to the inactive allergies list where you can reference them if needed.

Steps

1. Open the Medications and Allergies window: On any window related to the patient (including a
SOAP note or the medical summary), right-click and choose View Medication List. The
Medications and Allergies window opens, with the patient’s active allergies displayed in the
lower left pane.
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2. In the Active Allergies list, click the allergy or intolerance you want to refute and then, at the top of

the window, click Refute . The Refute <allergy type> area opens.

3. In the Details area, in the Reason list, select your reason for refuting the allergy. If none of the
options are appropriate, select Other - see text information and then, in the Comments field,
enter your reason.

4. In the Comments area, enter any additional notes.

5. Click Save. The allergy or intolerance moves to the Inactive Allergies list.

Deleting allergies and intolerances

If you record an allergy or intolerance in error (for example, if you enter an allergy in the wrong patient’s
chart), you can permanently delete the allergy or intolerance from the Active Allergies or Inactive
Allergies list. Deleted allergies and intolerances are not added to the patient’s Inactive Allergies list.
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Steps

1. Open the Medications and Allergies window: On any window related to the patient (including a
SOAP note or the medical summary), right-click and choose View Medication List.

2. In the Active Allergies list or the Inactive Allergies list, click the allergy or intolerance you want to

delete and then, at the top of the window, click Delete .

3. When prompted, click Yes.

Accessing the change log for patient allergies or intolerances

If you want to see a history of changes made to one of a patient’s allergies, you can view the allergy
log. The log includes information such as who has made changes, what changes were made, and
when the changes were made.

Steps

1. Open the Medications and Allergies window: On any window related to the patient (including a
SOAP note or the medical summary), right-click and choose View Medication List. Open the
Medications and Allergies window: On any window related to the patient (including a SOAP note,
and the medical summary), right-click and choose View Medication List or New Allergy.

2. In the Active Allergies or Inactive Allergies list, click the allergy you want to view a history for.

3. Click Log .

105

Allergies and intolerances



106

Vaccinations

When you record patient vaccinations, you can note who administered the vaccination, if the
vaccination was administered at another facility, or if the patient refused a recommended vaccination.

If you enter patient vaccination information appropriately, you can make use of the reminder and
reporting tools available for vaccinations. Using the Wolf EMR vaccination recommendation tool, you
can view at-a-glance what vaccinations your patients are due for. Also, using the Immunization
report, you can produce reports of vaccinations administered over a defined period of time.

To manage patient vaccinations, you can:

n Record a vaccination for a patient or group of patients ("Recording group vaccinations" on
page 113)

n View and modify a patient’s vaccinations ("Viewing and modifying patient vaccinations" on
page 117)

n Record that a patient had an adverse reaction to a vaccination ("Recording adverse reactions to
vaccinations" on page 118)

n Identify when a patient is due for a vaccination ("Identifying when patients are due for
vaccinations" on page 120)

n Produce immunization reports ("Producing immunization reports" on page 121)

n Configure lists and features around vaccination management ("Configuring vaccinations" on
page 123)

Recording a vaccination

You can record a patient vaccination from any window related to a patient via the SMART (right-click)
menu. The information required for recording a vaccination depends on who administered the
vaccination. If the vaccination was administered outside of your clinic, you are only required to enter
the vaccination name and approximate date.

If your clinic uses the Multum database, you can check for possible interactions (with a patients
current medications and medical problems) before you administer the vaccination.
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You can also record that a patient refused a vaccination (see "Recording refused vaccinations" on
page 112) and record a vaccination for an entire a group of patients at once (see "Recording group
vaccinations" on page 113).

Steps

1. Perform one of the following actions:

n If you have the patient’s medical summary open, on the Current Hx tab, in the Vaccinations
area, click <<Add Vaccination>>.

n If you have another window of the patient's medical record open (for example, a SOAP note,
or the Vitals Entry window), right-click and then, in the SMART menu, click New Vaccination.

n If you already have the Vaccinations window open, click Enter New Vaccination .

The Vaccinations window opens.

2. Using the following table, record the vaccination:
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Field Description

Vaccination
Date

Perform one of the following actions:

n If you know the date the vaccination was administered, in the Date

field, enter a date, or to select a date on a calendar, click .

n If you are recording a previous vaccination and are unsure of the
administration date, in the Approx field, enter an approximate date.
EMR translates the approximate date into a full date and displays
the date in the Date field.

You can enter the approximate date as:

n Month only: The EMR records the date as the first day of this month
in the current year.

n Year only: The EMR records the date as January 1 of the selected
year.

n Month and Year: The EMR records the date as the first day of the
entered month in the entered year. You can enter the month in full or
as an abbreviation. The year must be a four-digit year.

Location If your clinic has multiple locations, select the location where the
vaccination was administered.

Administration
Facility/Location

Perform one of the following actions:

n If the vaccination was administered in your clinic, select Clinic.

n If the vaccination was administered at a facility outside of your clinic,
select the facility. If the facility you want is not available in the list,
enter the facility in the field.

Best practice: If you enter a new Administration Facility,
you can choose to add the facility to the list. Add facilities to
the list only if you or other users will be selecting the location
often.

If needed, you can modify or delete Administration Facility list options
(for example, to “clean-up” duplicate or miss-spelled list items), see
"Managing the administration facility/location list for recording
vaccinations" on page 130.
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Field Description

Administered By Perform one of the following actions:

n If the individual who administered the vaccination was a practitioner
in your clinic, in the drop-down list, select Physician/Nurse Prac,
and then in the lower drop-down list, choose the practitioner.

n If the individual who administered the vaccination was a front end
staff member, in the drop-down list, select Staff, and then in the
lower drop-down list, choose the staff member.

n If the individual who administered the vaccination was from a facility
outside of your clinic, in the drop-down list, select Public Health,
and then in the field enter the name of the provider, pharmacy, or
clinic.

Vaccine Type all or part of the vaccination name (for example, flu or dpt), and
then on your keyboard, press Enter.

In the list of matching vaccinations, click the vaccination you want. The
full vaccination name populates the Vaccine field.

Note: If the vaccine you want is not available, users with
administrator authority can add vaccines to your clinic’s
vaccine list. See "Managing your clinic vaccine list" on
page 123.

Series Enter the series number of the vaccine, if applicable.
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Field Description

Lot # Perform one of the following actions:

n Choose a lot number from the list, if it was already entered on the
computer you are currently using. The Expiry date field is
automatically populated.

n Type a new lot number, and then in the Expiry field, type the lot’s
expiry date. You are prompted to register the lot number for future
use.

Tip: If you want to edit the Expiry date, click Edit Lot,
change the date, and then close the window.

Note: A particular lot number is not available in the drop-
down list if it expired or if the lot was marked as “Finished”

Route In the drop-down list, select the vaccination route.

Note: If the route you want is not in the list, you cannot enter
the value. Users with administrator authority can add
options to the Route list if needed via Configuration. See
"Managing the route list for recording vaccinations" on
page 127.

Tip: You can set a default value to automatically populate
the Route field. See "Managing your clinic vaccine list" on
page 123.

Dosage Enter the vaccination dose.

Tip: You can set a default value to automatically populate the Dosage
field. See "Managing your clinic vaccine list" on page 123.
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Field Description

Vaccination
Injection Site

Select the site where the vaccination was administered. If the injection
site you want is not available, then manually enter the value.

Best practice: If you enter a new injection site, you are
prompted to add the injection site to the drop-down list.
Add injection sites to the list only if:

n You or other users will be selecting the option often

n You can confirm that the option is not already available on the list
(perhaps as a different name?)

n You know you have spelled the injection site correctly

If needed, you can modify or delete Vaccination Injection Site drop-
down list options (for example, to “clean-up” duplicate or miss-spelled
list items). See "Managing the injection site list for recording
vaccinations" on page 127. See "Managing the injection sites and
reaction types lists for recording vaccinations" on page 129.

Notes Enter any notes regarding the patient's vaccination.

3. To review possible interactions for the vaccination, at the top of the window, click Multum.

Note:
You can check for possible interactions only if:

n Your clinic has the Cerner Multum database enabled

n The vaccine has a Multum code assigned. See "Managing your clinic vaccine
list" on page 123.

4. If the patient experiences an immediate adverse reaction to the vaccination, record the reaction.
See "Recording adverse reactions to vaccinations" on page 118.

5. If all of the patient’s primary immunizations are completed, at the top of the window, select the
Primary Immunizations have been Completed for this Patient check box. The EMR indicates
the completion of Primary Immunizations on the Current History tab in the Medical Summary
window.

6. Perform one of the following actions:
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n To record another vaccination click Enter New Vaccination and repeat steps step 2 to
step 6.

n To save the vaccination and close the window, click Close Form .

Recording refused vaccinations

If a patient refuses a vaccination, you can record and reference the refusal. This way, you know not to
offer the vaccination again, or to provide the patient with more information.

Note: If you record refused vaccinations, you can produce practice search reports
detailing patients who refused certain vaccinations. In Practice Search, use the search
parameter: Refused Vaccinations.

Steps

1. Open the Vaccinations window and record information in the following fields:

n Vaccination Date (date you offered the vaccination)

n *Administered By

n Vaccine

See step 1 to step 2 in "Recording a vaccination" on page 106.

2. Select the Refused check box.
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3. If the patient refused the vaccination on a date other than today, in the Date Refused field, enter

the date, or to select a date on a calendar, click .

4. In the Refusal Reason field, enter the patient’s reason for refusing the vaccination.

5. Save and close the window, or enter the next vaccination or refusal. See step 6 in "Recording a
vaccination" on page 106.

Recording group vaccinations

If you administer the same vaccination to a group of people (for example, if you administer a vaccine
to a family, or if you host a flu shot clinic), you can record the vaccination for all patients at once.

Note: You can record group vaccinations only for patients who have appointments
booked on the date the vaccinations took place.
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Steps

1. From the WorkDesk menu, click Patients > Group Vaccination . The Group Vaccination
window opens.

2. Using the following table, under 1. Select a Vaccination, enter the vaccination information.

Field Description

Vaccine Enter all or part of the vaccination name (for example, flu or dpt), and then
on your keyboard, press Enter. The EMR displays a list of matching
vaccinations.

Click the vaccination you want. The EMR displays the full vaccination
name in the Vaccine field.

Series # Enter the series number of the vaccine, if applicable.

Lot # Perform one of the following actions:

n To select a lot number that has previously been entered on the
computer you are currently using, in the list, click the vaccine's lot
number. The EMR displays the Expiry date for the selected lot.

n To enter a new lot number that has not been entered previously for
another patient, in the Lot # field, enter the lot number.

Expiry Enter the lot’s expiry date.

114

Vaccinations



Field Description

Route Select the vaccination route.

Note: If the route you want is not in the list, you cannot enter
the value. Users with administrator authority can add options
to the Route list if needed via Configuration. See "Managing
the route list for recording vaccinations" on page 127.

Dosage Enter the vaccination dose.

Vaccination
injection Site

Select the site where the vaccination was administered. If the injection site
you want is not available, then manually enter the value.

Best practice: If you enter a new injection site, you are
prompted to add the injection site to the list. Add injection
sites to the list only if:

n You or other users will be selecting the option often

n You can confirm that the option is not already available on the list
(perhaps as a different name?)

n You know you have spelled the injection site correctly

If needed, you can modify or delete Vaccination Injection Site list options
(for example, to “clean-up” duplicate or miss-spelled list items). See
"Managing the injection sites and reaction types lists for recording
vaccinations" on page 129"Managing the injection site list for recording
vaccinations" on page 127.
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Field Description

Location If your clinic has multiple locations, in the list, select the location the
vaccination was administered at.

Administration
Facility

perform one of the following actions:

n If the vaccination was administered in your clinic, in the drop-down
list, select Clinic.

n If the vaccination was administered at a facility outside of your clinic, in
the list click the facility. If the facility you want is not available in the list,
enter the facility in the field.

Best practice: If you enter a new Administration Facility,
you can choose to add the facility to the list. Add facilities to
the list only if you or other users will be selecting the location
often.

If needed, you can modify or delete Administration Facility list options
(for example, to “clean-up” duplicate or miss-spelled list items), see
"Managing the administration facility/location list for recording
vaccinations" on page 130.

Administered
By

Perform one of the following actions:

n If the individual who administered the vaccination was a provider in
your clinic, in the list, select Physician/Nurse Prac, and then in the
lower list, click the provider.

n If the individual who administered the vaccination was a front end staff
member, in the list, select Staff, and then in the lower list, click the staff
member.

n If the individual who administered the vaccination was from a facility
outside of your clinic, in the list, select Public Health, and then in the
field enter the name of the provider, pharmacy, or clinic.

3. Under 2. Select Patient:

a) In the *Appointment Date field, select the date the vaccinations took place.

b) In the Practitioner Filter list, select the provider whose patient’s were vaccinated, or if
patient’s from multiple providers were vaccinated, select <ANY>.
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c) If the patients whom were vaccinated had a common appointment reason (for example,
“injection”, or “vaccination”), in the Appointment Reason drop-down list, select the
reason, otherwise, leave <ANY> selected.

The EMR displays a list of patients whom meet the criteria outlined in this step.

4. In the list of patients, click a patient whom you want to record the vaccination for, and then click

. The EMR adds the patient to the Vaccination Records Created for Following Patients
area.

5. Repeat step 4 for all patients you want to record the vaccination for.

6. When you are done, click Close Form . The EMR records the vaccination in the medical
summary of all selected patients.

Viewing and modifying patient vaccinations

You can view a complete list of a patient’s recorded vaccinations in the patient’s medical summary. If
you want to view information about or modify information for a particular vaccination, in the list of
vaccinations, you double-click the vaccination.

Steps

1. Open the patient’s medical summary. The Vaccinations area displays:

n The patient's administered vaccinations.

n The patient’s refused vaccinations.

n The Primary Immunizes Completed check box.
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Note: To quickly indicate that a patient (no matter what age) has received all required
Primary Immunizations, select the Primary Immunizations Completed check box.

2. To view more detailed information about a vaccination, in the Vaccinations area, double-click the
vaccination. The Vaccinations window opens.

3. To view details on any interaction warning override(s), below the Notes area, click Drug
Interaction Overrides. The Drug Interaction Override History window opens.

4. In the Vaccinations window, modify information as needed. See step 2 in "Recording a
vaccination" on page 106.

Recording adverse reactions to vaccinations

If a patient experiences an adverse reaction to a vaccination, you can record the reaction in the
Vaccinations window and record an allergy or intolerance in the Medications and Allergies window at
the same time.

Steps

1. Open the vaccination record in the Vaccinations window: Open the patient’s medical summary
and then, in the Current Hx tab, in the Vaccinations area, double-click the vaccination.

2. In the Reaction list, select the type of reaction the patient experienced. The Medications and
Allergies window opens, with the Add Drug Allergy entry area open.
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Note: If your clinic still has the legacy allergy functionality (ie. you have not upgraded
to the new prescriber), the Clinical Records window opens instead. Here, you can
record the reaction details. See Managing allergies and intolerances using Wolf
EMR legacy functionality.

3. Record the reaction details, and then close the Medications and Allergies window. See
"Recording drug allergies and intolerances" on page 96.

4. If the patient has an adverse reaction that should be reported to the Public Health Agency of
Canada, in the Vaccinations window:

a) On the Vaccinations window, click the AEFI Report (Public Health Canada) link (located
below the *Reaction field). The Report of Adverse Events Following Immunization (AEFI)
SMART form opens with much of the patient’s information pre-populated.
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b) Complete, save, and optionally print or fax the form.

5. On the Vaccination window, click Close Form .

Identifying when patients are due for vaccinations

In Wolf EMR, you can create automatic notifications that display for patients who are due for
vaccinations (see "Managing automated vaccination recommendations" on page 131). These
automatic notifications are called vaccination recommendations. When a patient is due for a
vaccination, you are notified in the patient banner.

Steps

1. Open any window of the patient’s record (including the medical summary, the Vitals Entry
window, or a SOAP note).

2. In the SMART patient banner, click # Vaccinations (where # = the number of vaccinations the
patient is due for). The EMR displays the patient’s Vaccination Schedule, with:

n Upcoming (pending) vaccinations highlighted in dark blue

n Overdue vaccinations highlighted in orange

n Refused vaccinations highlighted in red

n Vaccinations administered late highlighted in light blue
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Note: As soon as you record an administered vaccine for a patient, the associated
vaccination recommendation no longer displays as “outstanding” on the patient's
Vaccination Schedule.

Producing immunization reports

You can produce a report of immunizations performed in your clinic over a defined period of time. The
report can detail administrations of a specific vaccine, and/or vaccinations administered by a
specific person.

Steps

1. From the WorkDesk menu, choose Reports > Immunization Records . The Immunization
Report window opens.
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2. Using the following table, enter criteria to define what immunizations should display in the report.

Field Description
From Enter the start date from which administered immunizations are to be

included, or to select a date from a calendar, click .

To Enter the end date to which administered immunizations are to be

included, or to select a date from a calendar, click .

Administered By

(Optional)

To include only vaccinations administered by a specific person, in the
list select the person.

Vaccine

(Optional)

To produce a report for only a specific vaccine, in the Vaccine list,
select the vaccine.

Include Public
Health / External

To include records that were administered externally or by public
health (those that have an Administered by value of External or Public
Health)

External or
Include Refusals
(CSV only)

To include vaccination refusals. This option applies only if you save
the report in CSV (comma separated value) file.

3. Click one of the following options:
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n Create CSV Extract File : To save the report as a CSV file that can be opened in various
spreadsheet and statistical analysis applications (for example, Microsoft Excel).

n Print to Default Printer : To print the prenatal record to your default printer.

n Print : To print or fax the report on a selected printer or fax machine.

Configuring vaccinations

To customize the process around recording vaccinations, you can:

n Add and modify vaccines in your clinic’s vaccine list (see "Managing your clinic vaccine list"
below)

n Customize the Route list (see "Managing the route list for recording vaccinations" on page 127)

n Customize the Injection Site list (see "Managing the injection sites and reaction types lists for
recording vaccinations" on page 129"Managing the injection site list for recording vaccinations"
on page 127

n Customize the Administration Facility/Location list (see "Managing the administration
facility/location list for recording vaccinations" on page 130)

n Configure automated vaccination recommendations (see "Managing automated vaccination
recommendations" on page 131)

Managing your clinic vaccine list

If a vaccine you want is not available in the vaccine list, you can add it if you have administrator
authority in Wolf EMR. You can also modify vaccines that are already on your clinic’s list, for example,
you can:

n Modify vaccine names.

n Set a default route and a default dosage for a vaccine. This way, when the vaccine is recorded in
patient charts, the Route and Dosage fields are populated automatically.

n Configure vaccines to display in CDM flowsheets using CDM codes.

Steps

1. From the Wolf EMR home page, click Configuration .
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2. From the Configuration window menu, click View > Patient Data Codes > Vaccination Types >
Vaccination Type Maintenance. The Vaccine Type Maintenance window opens.

3. Perform one of the following actions:

n If you are adding a vaccine, at the top of the window, click .

n If you are modifying or removing a vaccine, in the Vaccine Types Currently in Database list,
click the Description of the vaccine.

4. Using the following table, enter or modify the vaccine’s details.

Field Description

Description Enter the vaccine name.

Brand Name Enter the brand name.

Manufacturer Enter the manufacturer.
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Field Description

Route To set a default route for when this vaccine is recorded in patient charts, in
the list, select the route.

Note: If the route you want is not in the list, you cannot enter the
value. You can, however, add options to the Route list if
needed (via Configuration). See "Managing the route list for
recording vaccinations" on page 127.

Dosage To set a default dosage for when this vaccine is recorded in patient charts,
enter the dosage.

Care Type To associate this vaccine with a specific care type (for example, influenza),
in the list, select the care type.

End Date If you are removing the vaccine from your clinic’s vaccine list, enter the date
you want the vaccine to drop off the list.
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Field Description

CDM Code If you want the vaccine to display in chronic disease management (CDM)
flowsheets, select one of the following options:

n Influenza: To have vaccination dates display in the Influenza column of
CDM flowsheets

n Pneumococcal: To have vaccination dates display in the
Pneumococcal column of CDM flowsheets

n AbnormalPAPS: To have vaccination dates display in the Abnormal
PAPS column of CDM flowsheets

n LastPAPS: To have vaccination dates display in the LastPAPS column
of the CDM flowsheet

n PAPS: To have vaccination dates display in the PAPS column of the
CDM flowsheet

Note: You can also perform patient searches or create
automated clinical patient reminders (rules) using vaccination
CDM Codes. For this reason, you can add additional CDM
Codes to be used for patient searches and rules.

Note: If the CDM Code you want is not available in the list, any
user with administrator authority in Wolf EMR can add codes to
this list. See "Managing your clinic vaccination CDM codes" on
page 134.

eMS Code Select the vaccination code used by Electronic Medical Summary tools.

You can add codes to this list from Configuration > View > Patient Data
Codes > Vaccination Types > eMS Codes (BC).

Multum
Code

If your clinic uses the Cerner Multum interactions feature, enter the
vaccine’s Cerner Multum ID here.

Important : In assigning the correct Multum code, the EMR
can identify possible interactions for each patient.

Notes Enter any notes about the vaccine. These notes are for internal purposes
only, they do not populate patient vaccine entries.

5. When you are done, click , and then close the window.
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Managing the route list for recording vaccinations

When you record a vaccination for a patient, to record the route, you select an option in the Route list,
you cannot enter the value. If the option you want is not available in the list, users with administrator
authority can add options to the list via Wolf EMR Configuration.

Steps

1. From the Wolf EMR home page, click Configuration .

2. From the Configuration menu, chooseView > Patient Data Codes > Vaccination Types >
Route Maintenance. The Vaccination Route of Administration window opens.

3. To add an option to the list, in the left pane, click the option you want, and then click Add >.

4. To remove an option from the list, in the right pane, click the option, and then click < Remove.

5. When you are done, click Save and Close .

Managing the injection site list for recording vaccinations

When you record a vaccination for a patient, and you enter a new Injection Site, you can choose to
add the injection site to the list. Unfortunately, the ability to add injection sites on-the-fly can result in a
messy list of duplicate options, misspelled options, and so on. For this reason, you can “clean-up”
or modify the injection site list options if needed.

Steps

1. Open the Vaccinations window. See step 1 in "Recording a vaccination" on page 106.

2. Double-click the Vaccination Injection Site field tag.
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The Vaccination Injection Site Field List window opens.

3. Perform one of the following actions:

n To add an injection site, in the bottom row, enter the site.

n To edit a injection site name, click the injection site line, and then modify the text as needed.

n To delete a site, click the injection site line, and then on your keyboard, press Delete.
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4. When you are done, Click Close Form .

Managing the injection sites and reaction types lists for recording vaccinations

When you record a vaccination for a patient, you must select a Vaccination Injection Site and a
Reaction from a list. If the option that you want is not available in the list, users with administrator
authority can add options to the list via Wolf EMR Configuration.

Steps

1. From the Wolf EMR home page, click Configuration .

2. To manage injection sites:

a) In the Configuration window menu, click View > Patient Data Codes > Vaccination Types
> Injection Site Maintenance. The Injection Site Maintenance window opens.

b) To add an injection site, Click the New button and type a description. If you want to make
the side the default one, select the check box in the Default column. The injection site will
appear in the vaccination windows.

c) To modify an injection site, select the site and type a new description.

d) To delete an injection site, select the site and click the Delete button.

Note: You cannot delete injection sites that were already used in patient records.

3. To manage reactions:
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a) From the View menu, choose Patient Data Codes > Vaccination Types > Reaction Type
Maintenance.

b) Do one or more of the following:

n To add a reaction, in the left pane, click the reaction and click Add >.

n To remove a reaction, in the right pane click the reaction and click < Remove.

Managing the administration facility/location list for recording vaccinations

When you record a vaccination for a patient, and you enter a new Administration Facility/Location,
you can choose to add the facility to the list. Unfortunately, the ability to add Administration Facilities
on-the-fly can result in a messy list of duplicate options, misspelled options, and so on. For this
reason, you can “clean-up” or modify the Administration Facility list options if needed.

Steps

1. Open the Vaccinations window. See step 1 in "Recording a vaccination" on page 106.

2. Double-click the Administration Facility/Location field tag.

The Administration Facility/Location Field List window opens.
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3. Perform one of the following actions:

n To add a facility name, in the bottom row, enter the name.

n To edit a facility name, click the line, and then modify the text as needed.

n To delete a location, click the location line, and then on your keyboard, press Delete.

4. When you are done, click Close Form .

Managing automated vaccination recommendations

Because there are numerous vaccinations patients are recommended to take throughout their
lifetime, it can be hard to track if a patient is due for or missing a vaccination.

In Wolf EMR, you can create automatic notifications that displays for patients who are due for
vaccinations. To manage vaccination recommendations, you can:

n Define what criteria patients must meet to be flagged as overdue for a vaccination (see "Creating
vaccination recommendations" below)

n Halt vaccination recommendations; for example, if a vaccination is taken off the market, or if
clinical guidelines for a vaccination changes (see "Stopping vaccination recommendations" on
page 133)

Creating vaccination recommendations

You set criteria for overdue vaccination notifications by creating vaccination recommendations. Refer
to your province’s health authority for recommendations. Any user can create vaccination
recommendations via the WorkDesk menu.
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Steps

1. From the WorkDesk menu, click Configure > Vaccination Schedules . The Vaccination
Schedule Editor window opens.

2. In the Vaccine list, select a vaccine.

Tip:
If you are having trouble finding the vaccination you want, in the Vaccine field, begin
to enter the vaccine name. The EMR takes you to the appropriate place in the list.

Note: The list of vaccines originates from the Multum database. This list is regularly
updated.
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3. Using the following table, enter the schedule for the vaccine.

Column Description

Age to
Administer
(Days)

Enter the recommended age, in days.

Age to
Administer
Display
Text

Enter the recommended age in the format you want the age to display on the
Vaccination Schedule (for example, 12 months.)

Days
Required
Between
Series

If the vaccination is a series, enter the number of days required between each
vaccination in a series. For example, if two months is required between each
vaccination in the series, enter 60 to indicate 60 days.

Notes Enter any notes you want regarding the recommended vaccination.

Effective
From DOB

If the vaccine is new for infants/children, enter a starting date. The EMR
displays the vaccination recommendation only on the Vaccination Schedule
of patients who’s date of birth is AFTER the date specified.

Display Select to activate the vaccination schedule.

Tip: Use the horizontal scroll bar at the bottom of the Vaccine Schedule Editor
window to view the last few columns.

4. When you are done, click Close Form .

Stopping vaccination recommendations

If a vaccination is taken off the market, or if clinical guidelines for a vaccination changes, you can halt
automated recommendations for that vaccination.

Steps

1. On your WorkDesk, click Configure > Vaccination Schedules . The Vaccination Schedule
Editor window opens.

2. From the Vaccine list, select the vaccination you want to stop recommendations for. The EMR
displays the recommendations associated with the selected vaccine in the table below.

3. In the Effective To DOB column, enter an end date (Typically today’s date or an earlier date). The
EMR removes the recommendation for any patient born after the date specified.
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Managing your clinic vaccination CDM codes

Vaccination CDM codes are used to define what vaccines are to be tracked in the various chronic
disease management (CDM) flowsheets. You can also use CDM codes to produce searches and
automated patient reminders (rules) based on all vaccines defines by the same CDM code. Wolf
EMR does not come with a default set of CDM codes; However, if you use CDM flowsheets, you
should add the following codes:

n Influenza

n Pneumococcal

n AbnormalPAPS

n LastPAPS

n PAPS

Steps

1. From the Wolf EMR home page, click Configuration .

2. From the Configuration menu, choose View > Patient Data Codes > Vaccination Types > CDM
Codes. The CDM Vaccination Code Maintenance window opens.

3. Perform one of the following actions:

n If you are adding a vaccination CDM code, at the top of the window, click .

n If you are modifying or removing a vaccination CDM code, search for the code:

a) In the Description field, enter part or all of the CDM code name, and then click Search.

b) In the search results list, click the Internal Wolf ID of the CDM code you want to modify.

4. In the Data tab, in the Description field, enter a description for the CDM code (for example, you
can describe what flowsheets or searches this code is used for).

5. Enter the vaccination CDM code used by the Chronic Disease Management tools.

6. When you are done, click , and then close the window.
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